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Introduction 

About_this_Manual 

About this Manual 

The Label Gallery User Guide helps you design and print labels quickly. 
The User Guide contains the following sections: 
Introduction: This chapter will introduce you to Label Gallery software. 
Installation and Activation: Learn how to install and activate the labeling software. 
Setting up Label Gallery Software: Learn how to set up and customize software to your 
preferences. 
Designing Labels: Learn how to create labels. You should refer to this chapter regularly 
while designing labels, until you have completely familiarized yourself with the commands. 
By using the information contained in this chapter, you will be very quickly able to use 
labeling software efficiently. 
Printing and Previewing Labels: Learn how to print and preview labels. 
Integration and Connectivity: This chapter describes how labeling software can be used for 
seamless integration of label printing to your custom applications and which connectivity 
methods are available for including labelling to information systems without any 
modifications to existing applications. 
Interface Reference: This chapter describes details and explains all the commands used in 
the labeling software. 
Technical Support: Contacting technical support. 

Software Restrictions 

All features explained in the Quick Start Guide are available in the Label Gallery TruePro 
edition. However, some features are not available in the Label Gallery Plus or Label Gallery 
Easy editions. Sections discussing features not available with Label Gallery Plus or Label 
Gallery Easy will display an alert icon. 

Typographical Conventions 

Text that appears in bold refers to menu names and buttons like the OK button. 
Text that appears in italic refers to options, confirming actions like Read only and locations 
like Folder. 
Text enclosed in <Less-Than and Greater-Than signs> refers to keys from the desktop PC 
keyboard like <Enter>. 
Variables are enclosed in [brackets] like [variable]. 
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Product_Overview 

GalleryEngine 

GalleryEngine is an ActiveX integrator edition of Label Gallery software developed for 
software publishers who need label printing capabilities in their software. GalleryEngine can 
be embedded in existing information systems or existing applications to provide support for 
label printing. GalleryEngine provides all label printing functionality of the Label Gallery 
software. 

Label Gallery Easy 

Wizard-based software meeting basic bar code labeling needs. The entry-level software 
includes many design elements of the Plus edition with the emphasis on simplified user 
interaction. 

Label Gallery Free 

Wizard-based software meeting basic barcode labeling needs. This edition is fully functional 
but comes with some limited functionality. 
 

Note: 
No hardware key is required for this edition. 

Label Gallery Plus 

Full-featured software designed for professional label design and printing, including complete 
database support and ActiveX integration possibilities. A wide range of features and options 
makes Label Gallery Plus a perfect and easy-to-use tool for any labeling requirement. 
Label Gallery Plus includes the following modules: 
Label Gallery Plus: Main application for label design and printing. 
GalleryMemMaster: Download fonts and graphics to the computer’s memory card for 
optimized label printing. 
GalleryData: Manage your databases. 

Label Gallery Plus Print Only 

Label Gallery Plus Print Only offers printing of pre-designed labels but cannot be used to 
design and alter existing labels. Advanced settings for changing the labels are not available. 

Label Gallery TruePro 

Complete software solution for any kind of label design and print requirement. Multiple 
connectivity options allow users to perform stand-alone printing or integrate label printing 
into any network environment. 
Label Gallery TruePro provides you with the interactive label printing capabilities. You can 
also integrate label printing to existing applications (ActiveX). Non-programming embedding 
of label printing to existing systems is also available (GalleryWatch). 
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Label Gallery TruePro includes the following modules: 
• Label Gallery Plus: Main application for label design and printing. 
• GalleryForm: Create your own custom designed data-entry applications without 

requiring any programming skills. 
• GalleryWatch: Integrate and automate label printing to any existing information 

system. 
• GalleryMemMaster: Download fonts and graphics to the computer’s memory card 

for optimized label printing. 
• GalleryData: Manage your databases. 
• GalleryPrint: Print your labels from this easy-to-use application 

Label Gallery TreuPro Print Only 

Label Gallery TruePro Print Only offers printing of pre-designed labels, using pre-designed 
forms and automatic printing from pre-designed trigger actions. Label Gallery TruePro Print 
Only cannot be used to design and alter existing labels, forms and trigger configuration. 
Advanced settings for changing the labels are not available. 

Pocket Label Gallery 

Pocket Label Gallery is a program package for Windows CE that brings the power of label 
printing to portable Windows CE computers (Windows Mobile Device). 

Contents of the Package 
Before starting the installation of Label Gallery software check the contents of the package to 
ensure it is complete. The package must include: 

• Label Gallery CD 
• Quick Start Guide 
• Software key on a sticker or hardware key (not available with all editions) 

If any of the mentioned items are missing, please contact your software vendor immediately 
for package replacement. 

Welcome to Label Gallery 
Label Gallery is a family of professional labeling software products that brings a complete bar 
code printing solution and RFID Smart Label printing to desktop, mobile and enterprise users. 
Label Gallery offers an easy-to-use interface and meets any label design and printing 
requirement for efficient label printing solutions to users in retail, logistics, health care, 
chemical, automotive and other industries. The main product lines include Label Gallery 
Dynamic TruePro, Label Gallery TruePro Print Only, Label Gallery Dynamic Plus, Label 
Gallery Dynamic Plus Print Only, Label Gallery TruePro, Label Gallery Plus, Label Gallery 
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Easy, Label Gallery Free, Label Gallery Dynamic TruePro Network, Label Gallery TruePro 
Network and Pocket Label Gallery. 
Label Gallery can be used with 32-bit Windows operating systems: Windows 98 SE, 
Windows NT 4.0, Windows ME, Windows 2000, Windows XP and Windows Server 2003.  
The latest software is available for free download on the Label Gallery website at 
www.satoworldwide.com. 
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Installation and Activation 

Activating Software 

Activate Network Client 

The Network client you have used for activation of the Label Gallery Network server is 
automatically activated as well. To activate additional Label Gallery Network clients on other 
workstations please follow these steps: 
After the installation is complete, run Label Gallery software. No valid license is found and 
the window Manage License opens.  
Select the Network Software Key and click on Next button. 
Browse for the location where the Label Gallery Network was installed and click on the Next 
button. 
The license information will be copied from the server. 

Note: 
Make sure you are using UNC syntax when referring to the network location. Use the 
syntax \\server\share\file and not the syntax with the mapped drive like W:\share\file. 

Label Gallery Network client is activated. The Label Gallery client can run on the workatation 
only if the Label Gallery server has enough licenses available. If no license is available, you 
will have to wait until one of the currently running clients logs off. 

Activating Pocket Label Gallery 

Note: 
The text in this topic applies to Label Gallery TruePro edition that includes one Pocket 
Label Gallery Client Access License. 

The licensed version of Pocket Label Gallery comes with a 10-digit Client Access License 
(CAL) number that releases the application from DEMO mode and enables you to print labels 
without limitations from your Windows Mobile Device. 
To get your Client Access License for Pocket Label Gallery, you must have the access to the 
internet from your computer. Do the following: 

1. Start Label Gallery Plus. 
2. Select Menage License from the Help menu. 
3. Tick the option Manage current software key license. 

Click Next. 
4. Select the option Get Pocket PC edition software key. 

Click Next. 
The Pocket Label Gallery activation web page will open. 

5. Make sure that your Software Key Number is correctly entered. 
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6. Click on the button Get Free Pocket Label Gallery Key. 
The Pocket Label Gallery Key will be displayed on the screen. 

 
To register Pocket Label Gallery on your Windows Mobile Device, do the following steps: 

1. Open Start/ Programs/ Pocket Label Gallery folder/ Pocket Label Gallery (or Pocket 
GalleryForm). 

2. Read the DEMO warning and tap the YES button. 

 
3. Enter the required information into the registration dialog box on the Mobile Device 

and tap the Activate button. 

 
Activating Pocket Label Gallery with your Mobile Device will remove the DEMO mode 
limitations. The CAL number you received with your initial Label Gallery TruePro with 
WindowsCE support is only valid for one (1) Mobile Device. If you want to use Pocket Label 
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Gallery with more than one Mobile Device, contact your Label Gallery reseller to upgrade the 
Client Access License for multiple devices. 

Activation on the Web 

Label Gallery activation on the Web only works with network software key. If the computer 
that uses the Label Gallery software is not connected to the Internet, you will have to open the 
Activation Web page on the computer with internet access and acquire the activation 
information on that computer. 
Before you start the activation process of Label Gallery software, get familiar with the 
following terminology: 

• Key number: The sequence of 25 characters provided with the Label Gallery 
software. 

• Registration number: Unique number generated during the activation process. The 
registration number validates the entered software key. 

• Activation code: Issued on the Label Gallery activation Web site. The activation code 
activates the Label Gallery software on your computer. 

To activate Label Gallery software, do the following: 
1. After the installation is complete, run Label Gallery software. No valid license is 

found and the window Manage License opens.  

 
Selecting 'Single-user Software Key' activation 

2. Select Network Software Key and click on Next.  
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3. Enter the required customer information and the key number then click on the Next 
button. The window for validation of the Key Number will open. You are required to 
verify your Key Number on the internet. 
 
You can activate the software using the automatic activation (recommended) or 
manual activation on the web site. 

4. To activate the software automatically, click on the link Connect to the Activation 
server. 
 
To activate the software manually, click on the provided internet link for web page 
activation. 
Internet Explorer will open and connect to the Label Gallery software internet 
activation website. 

 
Internet activation website 

5. Enter the Key Number and the Registration Number. Enter other user information, if 
prompted. 

6. Click on the Activate button to retrieve the Activation Code. 
7. Switch back to the window Manage License. 

Enter the Activation Code. 
8. Click on the Next button. 

Follow the prompts to complete the activation process. 
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Note: 
You can still activate Label Gallery software, if the computer does not have access to 
the internet. Please refer to the following section. 

If the computer where you installed Label Gallery software does not have the internet access, 
do the following: 

1. Follow the steps one (1) to four  (4) from the previous section. 
2. Write down the Key Number and the Registration Number. 
3. Write down the internet activation web address. 
4. Go to the computer with the internet access and open the activation website in the 

Internet Explorer. 
5. Enter the Key Number and the Registration Number. Enter other user information 

when prompted. 
6. Click on the Register button to retrieve the Activation code. Write it down. 

Note: 
The information in the Key Number and Registration Number, the Activation Code and 
other fields is case-sensitive, so be careful when writing it down. 

7. Go back to the Label Gallery computer (without the internet access) where the 
window Manage License is still opened. 

8. Enter the Activation Code. 
9. Click on the Next button and follow the prompts to complete the activation process. 

Install Parallel Hardware Key 

Make sure you have finished installing the Label Gallery software on your PC. 

 
To install a parallel key, do the following: 

1. Shutdown your computer and switch off your printer. 
2. Connect the hardware key directly to the parallel port (marked as LPT or PRN port) 

on your computer. 
Make sure you connect the hardware key in such a manner that pins on the key plug 
into the holes in the computer port. Fasten the two screws to secure the key. 

Note: 
Do not remove the screws or try to turn them inside out. 
Never try to connect the key to a serial port on the computer or directly to a printer. You 
can permanently damage the hardware key as well as your computer equipment. 
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3. Start Label Gallery software. The Product Activation dialog box will open. 
4. Select Hardware Key and click on Next. 

If the hardware key is connected properly, Label Gallery software will start. 
Note: 
If you own a serial printer, you cannot connect the printer to the hardware key directly 
because the connectors are not compatible. Always connect your serial printer to the 
serial port and hardware key to the parallel port. Your printer does not need to print 
"through" the hardware key. 

Install USB Hardware Key 

Make sure you have finished installing the Label Gallery software on your PC. 

 
To install a USB key, do the following: 

1. Plug the USB key into an available USB port. 
2. Start Label Gallery software. The Product Activation dialog box will open. 
3. Select Hardware Key and click on Next. 
4. If the hardware key is connected properly, Label Gallery software will start. 

Note: 
Windows NT operating system does not natively support USB devices. You will have 
to install the USB driver on your system first. The Label Gallery CD provides you with 
a proprietary USB driver. To install the USB driver, follow the enclosed installation 
instructions in the file USB4NT.ZIP in the folder \Updates\HASP. 

Activating Software 

The following activation instructions work for single-user and network Label Gallery 
editions. 
You have to activate the Label Gallery software if you want to use it. If you do not complete 
the activation process, Label Gallery will run in demo mode. 
The Product Activation utility will always run after installation. You can also start activation 
from Label Gallery software, if you want to change the activation type or add more licenses to 
your network edition.  
There are two types of Label Gallery software activation:  

• Hardware key activation 
• Network Software key activation 
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Note: 
Label Gallery Easy and Label Gallery Plus editions do not have the network licensing. 

Hardware key activation: 
Label Gallery software editions with hardware key can be used immediately after installation. 
If you have a Label Gallery edition with a hardware key, please skip ahead to the chapter 
Install Parallel Hardware Key or Install USB Hardware Key. 
Network Software key activation: 
You can activate the server part of the Label Gallery Network edition through activation on 
the Web. Key number is a sequence of 25 characters. Activating the server part will also 
activate the client on the current workstation. If you upgrade the network edition with 
additional users, you have to install and activate each additional workstation separately. Refer 
to the chapter Activate Network client. 

Activating Upgrades 

Activating Edition Upgrade 

When you upgrade to a new edition of Label Gallery software, for example from Label 
Gallery Easy to Label Gallery Plus, you have to remove the existing Label Gallery edition and 
install and activate the new Label Gallery edition. Follow the steps in the chapter Installing 
Software. 
Summary of required steps: 

1. Close all Label Gallery applications. 
2. Remove the existing Label Gallery edition. 
3. Install the new Label Gallery edition. 
4. Activate the new Label Gallery edition. 

Activating Version Upgrade 

When you upgrade to a new Label Gallery version of the same edition, for example Label 
Gallery Plus version 2.0 to Label Gallery Plus version 2.1, the software will remain activated. 
Just make sure to install the new version on top of the existing version. Please follow the 
same instructions as for the first-time installation of Label Gallery in the chapter Installing 
Software. 
Summary of required steps: 

1. Close running Label Gallery applications. 
2. Do not remove the existing version of Label Gallery software. 
3. Make the upgrade over the existing version to preserve the activation information. 
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Installing Network Edition 

Define Access Rights for Network Clients 

Administrator rights to the local computer 
at the install time 

The user that is installing Label Gallery on 
the client computer has to be either 
Administrator or member of the 
Administrator group. 

Read-write access to 
HKEY_LOCAL_MACHINE\SOFTWARE 
key at install time, read-only access at 
Label Gallery run time. 

It is vital to have Administrator rights to be 
able to update Label Gallery-related 
information in the registry. Windows 
Registry is used to store information about 
Label Gallery installation, file folders and 
to register Label Gallery software 
components and modules. Read-write 
access is required at install time. Read-
only access is required at any other time 
when Label Gallery software is run. 

Read-write access to 
HKEY_CURRENT_USER\SOFTWARE 
key. 

User-specific Label Gallery settings are 
stored within this registry key. Every user 
that logs on the computer has his own 
settings. User has to be able to update his 
information. 

Read-write access to the System folder in 
the server installation of Label Gallery. 

Label Gallery server version is installed on 
some computer that has the role of file 
server. No Label Gallery software is 
running on this server computer, only files 
are shared for Label Gallery clients. The 
folder where Label Gallery server is 
installed has to be shared to the clients. 
The share mode for all files can be set to 
read-only mode, except for one folder. The 
System folder has to be shared in full mode 
(read-write, delete) mode to the client 
computers. Every client must be able to 
update files in here. 

Access to the printer drivers. User has to be able to access printer drivers 
in order to use them for label printing. It 
depends on the Windows system that is 
used, but permissions for Print and Read 
permissions should be sufficient. 
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Enable Offline Mode for Network Edition 

Label Gallery Network depends on the network server that holds Label Gallery program files 
and common data used by all workstations. In case of server or network failure, the whole 
system would fail. Off-line mode successfully copes with such situations and workstations are 
still able to operate, but some limitations apply. 
The other case of Off-line usage is the use of labeling software with mobile users. In a 
company that has a Network version of Label Gallery installed some of the workstation 
installs are performed on laptop computers. If this computer is detached from the network, 
Label Gallery software will not operate. Off-line mode successfully copes with this situation. 
Switching Label Gallery to off-line mode is done with License Manager program. When you 
start License Manager from Help menu, it will use one license for itself. This currently 
occupied license can be assigned as Available Off-line. When this option is enabled, the 
workstation used will be able to operate without the server or network being on-line and will 
still occupy this one license.  
Off-line mode causes the license to be used all the time. When Label Gallery Network is 
started, it does not occupy another license, and after it quits it also does not release this 
license. The number of all available licenses is thus reduced by one. If the off-line license 
needs to be released, use License Manager for this task. Click the Disable Off-line button and 
off-line mode will be cancelled and license released. 
The system requirement for off-line mode to work is local installation of Label Gallery 
software. Make sure to select the option Copy files to local hard disk in install program on all 
workstations for which you want to enable off-line mode. All Label Gallery program files 
must be installed to the local disk. 
When Label Gallery software is started in off-line mode it will use local copy of Label 
Gallery system files. For this purpose a local copy of System folder from Label Gallery server 
computer will be made. When Label Gallery Plus starts it will determine if server is 
accessible. If it is, server files will be used. If not, local copy of system files will be used. 
When the workstation is running in off line mode, there are few important issues that have to 
be considered. All functionality of Label Gallery TruePro Network is not available in off-line 
mode. 

Install on Windows Terminal Services and Citrix Metaframe 

Before you start with the Network installation on the Windows Terminal Services or Citrix 
Metaframe, read the White Paper: Using Label Gallery software with Windows 2000 
Terminal Services and Citrix Metaframe. The White Paper is available on Label Gallery 
CD or for download from the Label Gallery website. 

Install the Software on the Server 

Please follow these steps to install Label Gallery software on the server computer: 
1. Put the Label Gallery CD in your CD-ROM drive. An installation window will open 

automatically. 

Note: 
If the installation wizard does not start automatically, go to the main CD directory of 
your Label Gallery CD and double-click on the file START.EXE. 



Label Gallery User Guide 

14 

2. Click on Install. A new window will open showing all Label Gallery editions. 
3. Click on Label Gallery TruePro. 
4. Click on Label Gallery TruePro Network. Installation will start. 

Note: 
If you do not see the option Label Gallery TruePro Network listed, you are trying to 
installing Label Gallery TruePro Network from a computer that already has stand-alone 
Label Gallery installed. In this case you can do the following: 
• Run Label Gallery TruePro Network installation on some other computer. 
• Start the installation manually with command-line switch /netinstall like this: 
 
SETUP.EXE /netinstall 
 
If running installation from Label Gallery CD, the SETUP.EXE resides in the folder 
\Setup\LabelGallery. 

5. Follow the installation prompts. 
6. Browse to the folder on the server where you want to install Label Gallery server. 
7. Click on the Next button to finish the installation.  

Note: 
You should select a server and disk share that is visible to all workstations in the 
domain where you intend to use Label Gallery software. 

Install the Software on the Workstation 

There are two ways how you can install the Label Gallery Network client on the workstation: 
Installing the client from CD. 
Install Label Gallery TruePro single user software from the Label Gallery CD as described in 
the chapter Installing Software. Just make sure to select the Network activation type in the 
Product Activation utility. 
Installing the client from the network. 
Install Label Gallery client by running the installation file WORKSTAT.EXE from the Label 
Gallery server.  
Follow these steps to install the client from the network: 

1. Open Windows Explorer. 
2. Browse to the Label Gallery server computer in My Network Places. 
3. Browse to the folder where Label Gallery software is installed on the server. 
4. Double click on the file SETUP.EXE. 
5. Follow on-screen instructions. For detailed instructions you can also refer to the 

installation of the single user edition in the chapter Installing Label Gallery Software. 
Note: 
Label Gallery client installed on the workstation must have full access (read, write, 
delete) to the Label Gallery System subfolder on the server computer. 

6. Click on Finish button to finish the installation. 
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Limitations of the Network Offline Mode 

Global 
variables 

Global variables cannot be used in off line 
mode. If the local copy of global variable 
and a copy on another workstation or 
server would be used at the same time, the 
serial numbers would be duplicated. 

Log file If you are using MS Access log file, the 
log will be created, but will not be merged 
with the main system log file when on-line 
mode is restored. 
If you are using Text log file is used and 
the path to the log file is not accessible, the 
log file will be non-operational. 

Location 
of labels, 
database, 
graphics, 
etc. 

The availability of necessary label files is 
up to the user. Label Gallery will not 
duplicate these files. 
If you are using Windows 2000 (or newer) 
environment, you can enable off-line 
system accessibility directly in the 
Windows system with the option Make 
Available Off-line. 

Number 
of off-line 
clients 

The maximum number of off-line 
workstations is limited to half of the 
purchased licenses. 

Login 
protection 

Login protection and custom Label Gallery 
usernames are disabled in off-line mode 

Lease 
period 

Off-line client cannot occupy a Label 
Gallery license for unlimited period of 
time. Maximum lease period of every 
license is 15 days. If the client does not 
reconnect to the server in on-line mode in 
this time period, its license will expire and 
be released to some other client. 
Lease period also considers the license 
used by a computer that will never login in 
on-line mode and normally release it 
(computer crashed beyond repair, 
computer got stolen etc.). When lease 
period expires, the license will be returned 
to the group of available licenses on the 
server. 
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Migrate Network Edition to New Server Computer 

This top provides you with information what you have to pay a special attention to, if you 
want to migrate Label Gallery Network to another server computer. 

1. First prepare the new server computer. You will have to install the same version of 
Label Gallery TruePro Network to it from scratch. Please refer to the topic Install 
Software to the Server how it is done. You can use your existing Network Key 
Number, if you have not already reached the activation limit. 

Note: 
If your Network Key Number cannot be used for the additional activation of the 
software, contact your vendor. 

2. When the new server computer has Label Gallery properly installed and activated, the 
only thing left to do is to restore the previous program settings and data files. 

The files that need to be copied on the new server computer, if you want to retain the 
previous settings, are: 

• Global variables (GLOBALS.TDB) 
• Label Gallery settings and list of users (SETTINGSDB.MDB) 
• Log file (LOGDATABASE.MDB) 
• Custom algorithm definition file (ALGO.DEF) 
• Stock database (STOCKDB.MDB) 

These files are located in the System folder of the server installation. When this step is 
completed, new Label Gallery installation should have the same settings as the old one. 

Note: 
Make sure, that no user is running Label Gallery at the time, when you copy files, so the 
files can be overwritten. 

3. You must perform One more task is remaining to be done. You probably want to copy 
the label, form and database files to the new server computer as well. By default Label 
Gallery uses the directory structure with several subfolders, each for its own files: 

• Labels for label files (.LBL) 
• Forms for form files (.OFF) 
• Database for database files 

Copy the contents of these folders to the new server to create duplicated file storage. 

Overview 

Label Gallery Network software consists of two parts: the server and the workstation. First, 
you must install Label Gallery software on the server computer and make all files accessible 
to the clients. Then you can install Label Gallery software on the workstation (client). Client 
installation is possible from the Label Gallery server or from the Label Gallery CD. 

Note: 
Label Gallery Easy and Label Gallery Plus editions are not available with network 
licenses. Only Label Gallery TruePro edition is available with network licensing. 
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Recovering Lost Licenses 

When Label Gallery client connects to the server, one license gets occupied. If from some 
reason the client computer stops responding, freezes or locks up and you are forces to reboot 
it, the license will still remain in use on the server. 
There is a simple way to recover such license. When computer restarts just re-run Label 
Gallery software. The client will find its previous license on the server and will not occupy 
another one. Then close Label Gallery software and the license will be released. 

Using License Manager 

The program License Manager is used to monitor and manage network licenses. License 
Manager displays the information of the current client and also provides an overview of the 
total license occupation. 
You can also use it to enable/disable off-line mode for workstations. Off-line mode enables 
selected workstations to function in spite of the fact that Label Gallery server computer is not 
available or not accessible. It is used in environments where mobile label printing is required 
or in events where server system failure would otherwise stop the label production. 
Force Off-line Mode: The client will not check for the presence of the network server. The 
client will automatically start in the off-line mode. When the license lease expires it will stop 
running and you must renew the license by switching off this option and re-connecting to the 
network server. 

Note: 
The off-line license expires after 14 days. 

Application Settings Location: Label Gallery software stores the setting in the System 
folder. By default, the System folder is available on the network server and is shared among 
all network clients. But you can also store the settings on the local workstation where they are 
accessible to your Label Gallery client only. 
The table at the bottom of the dialog box displays the occupation of the licenses.  

Installing Pocket Edition 

Install Pocket Label Gallery 

Before you install Pocket Label Gallery, make sure you have the following: 
• Label Gallery CD-ROM 
• User Guide for Pocket Label Gallery 
• 10-digit Serial Number (Client Access Number) 

Note: 
If your desktop PC runs Windows NT, 2000 or XP, you have to log on with 
administrator rights to be able to install the software properly. Furthermore, you must 
ensure that your Mobile Device works properly, including file synchronization with 
ActiveSync and any printing capabilities your Mobile Device supports. 
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There are two ways to install Pocket Label Gallery: You can either follow the installation 
wizard on the Label Gallery CD-ROM or transfer the appropriate .CAB file to your Mobile 
Device manually. 
Installation Wizard: 

1. Connect your Mobile Device to the desktop PC.  
2. Make sure that an ActiveSync partnership is established between the desktop PC and 

Mobile Device. 
3. Put the Label Gallery CD-ROM in your CD drive.  The STARTUP.EXE application 

will start automatically. If not, go the folder ‘X:\?and click on the file START.EXE 
('X' stands for the letter of your CD-ROM drive). The window Label Gallery 
Product CD will open. 

4. Click on Install. 
5. Click on Mobile Printing Editions (WinCE). 
6. Click on Pocket Label Gallery and follow the prompts. 
7. Select the correct Operating System or Platform for your Mobile Device. 

 
Selecting the platform of your Mobile Device 

Note: 
If you select the wrong platform here, you won't be able to install and register Pocket 
Label Gallery on your Mobile Device. If you are not sure what operating system (or 
platform) your Mobile Device uses, check your documentation or your system 
information under settings/control panel or in the Help menu of your Mobile Device. 

8. Follow the prompts to finish the installation. 
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9. If Pocket Label Gallery installation on your desktop PC is complete, ActiveSync will 
start and transfer the necessary files to the Mobile Device. Follow the prompts on both 
the desktop PC and Mobile Device. 

The Pocket Label Gallery application will be stored in the folder \Program Files\Pocket 
LabelGallery. Pocket Label Gallery will also appear in the Start\ Program menu of your 
Mobile Device. 
 
Transfer .CAB file to your Mobile Device 
Instead of using the installation wizard and starting SETUP.EXE from the Label Gallery CD-
ROM, you can transfer the correct .CAB file to the Mobile Device by doing the following: 

1. Create a synchronization folder for your Mobile Device on your desktop PC.  
You might have done that already when you setup the communication between your 
desktop PC and Mobile Device. 

2. Put the Label Gallery CD-ROM in your CD drive and go to the folder 
X:\Setup\WindowsCE ('X' stands for the letter of your CD-ROM drive). 

3. Open the folder with the name of the Operating System or Platform of your Mobile 
Device. 

4. Select the .CAB file that mentions your Operating System or platform before the 
.CAB extension.  

5. Copy that file to your synchronization folder for your Mobile Device. 
6. Transfer the .CAB file to your Mobile Device using ActiveSync. 

 
Complete installation on your Mobile Device: 

7. Open File Explorer and select the transferred .CAB file on your Mobile Device.  
8. Tab or open the file (depends on your Mobile Device) and follow the prompts on the 

screen of your Mobile Device. 
The Pocket Label Gallery application will be stored in the folder \Program Files\Pocket 
LabelGallery. Pocket Label Gallery will also appear in the Start\ Program menu of your 
Mobile Device. 

Overview 

Pocket Label Gallery enables you to create robust data entry screens for your mobile device. 
With the help of Pocket Label Gallery users can print bar code labels directly with Windows 
Mobile Devices that are connected with thermal printers through WiFi, Bluetooth, Infrared or 
serial cable. In addition, Pocket Label Gallery enables bar code label printing in a network 
environment. Using GalleryWatch, you can print bar code labels to a centralized print server 
that handles printing and driver selection. Pocket Label Gallery and centralized printing 
through GalleryWatch offer a truly mobile distributed printing application. 
Pocket Label Gallery can also be used as a print engine (ActiveX server) to enable other 
applications on your mobile device to control label printing functions. Using Pocket Label 
Gallery as a print engine appeals to system integrators and software developers who wish to 
utilize Pocket Label Gallery as a label printing module for their mobile applications. For more 
information about utilizing Pocket Label Gallery as a print engine in a customized mobile 
Windows application, please see our Web site at www.satoworldwide.com. 
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Setup and Test Mobile Device Setup 

Before you can install Pocket Label Gallery, you have to familiarize yourself with your 
Mobile Device. You must know what processor type and what Windows CE operating system 
your device uses. In addition, you have to be able to establish functioning communication 
between both your desktop computer and Mobile Device through an established ActiveSync 
partnership, Mobile Device and (thermal) label printer through serial cable, WiFi, Infrared or 
Bluetooth.  
Please refer to the documentation of your mobile device to learn about processor, operating 
system and how to establish different communication modes. 

Installing Software 

Install Printer Driver 

Install Printer Driver 

You can use the Label Gallery software (Dynamic edition) to design and print labels to 
standard office printers (laser, inkjet or matrix) or to SATO label printers (thermal printers). If 
you own a SATO thermal printer, you have to install the appropriate printer driver before you 
can print with the label printer. You will find GalleryDriver on the Label Gallery CD and on 
the Label Gallery website. 
You can install a GalleryDriver for your SATO thermal printer in the following three ways: 

• Install within the Label Gallery software installation.  
• Use the Printer Installation Wizard. 
• Use the Windows Add Printer Wizard. 

Printer Installation Using the Printer Installation Wizard 

1. Put the Label Gallery CD in your CD-ROM drive. The main installation application should 
start automatically. If not, start Windows Explorer, browse to the CD and double click on the 
file START.EXE. 
2. Click on Installation. A new window will open showing all Label Gallery editions. 
3. Click on GalleryDriver. The printer installation wizard will start. 
4. Select your printer from the list. Click on the Next button. 
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Selecting SATO thermal printer 

5. Select the port where you have connected your printer and click on the Finish button. 
Note: 
If you have downloaded the installation for GalleryDriver from the Label Gallery 
website, run the downloaded .EXE file and follow the steps four (4) and five (5). 

 

Printer Installation Using the Windows Add Printer Wizard 

1. Open Control Panel from Settings option in Start menu. 
2. Open Printers (Printers and Faxes) and select Add a Printer. 
3. Follow the Add Printer Wizard prompts. The actual steps vary depending on the 

version of your Windows operating system. It is only important to click on the Have 
disk button in the step where you can select printer manufacturer and model. 

4. Put the Label Gallery CD in your CD-ROM drive (if not already done so) and browse 
to the folder \Drivers.  

5. Select the folder of your printer name and click on Open/OK buttons to return to the 
Add Printer Wizard. You will see the list of all available printer models of the selected 
printer. 

6. Select your model, click on the Next button and finish the installation. 
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SATO printer drivers are digitally signed drivers 

Printer installation within software installation 

To continue installing the GalleryDriver after setup has finished the Label Gallery software 
installation, do the following: 

1. Select the option Install printer driver. 
2. Click on the Finish button. 

 
Installing Label Gallery driver for thermal printer 

3. Printer Installation Wizard will open. 
4. Select your printer from the list. Click on the Next button. 
5. Select the port where you have connected your printer and click on the Finish button. 

Note: 
This type of printer installation is available only when running installation from Label 
Gallery CD. 
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Close All Software Applications 

To ensure complete installation of the Label Gallery software, close all open software 
applications before you start installing the Label Gallery software. 

Define Setup Options 

You can select the components of the selected Label Gallery edition that you want to install. 
You can choose among the following three types of installations: 
Full Installation - installs all Label Gallery components in all available languages. 
Compact Installation - installs only minimal set of components required for Label Gallery 
application to work correctly. Help and sample files are not installed. 
Custom Installation ?gives you the option to select individual components for installation. 
To continue installation, do the following: 

1. Click on the Next button. 
2. Specify the program group you want to use for the Label Gallery software. 
3. Specify if shortcuts to Label Gallery software should be created on the desktop or in 

Quick Launch area. 
4. Click on the Install button to finish the installation. 
5. The Start menu in your Windows will show a new program group for the Label 

Gallery software that contains shortcuts for all Label Gallery applications. 

Installing Software 

When you put the Label Gallery CD in your CD-ROM drive, the installation/demonstration 
program will start automatically. You can browse the directory of the CD, look at the 
brochures and technical documentation, sample files and other documents. 

Note: 
If you are using Windows NT, 2000, XP or 2003, you have to log on with Administrator 
rights to be able to perform installation. 

 

Run SETUP.EXE 

Use the installation wizard to install Label Gallery software on your desktop PC. To install 
Label Gallery software, do the following: 

1. Put the Label Gallery CD in your CD-ROM drive. An installation window will open 
automatically. 

Note: 
If the installation wizard does not start automatically, go to the main CD directory of 
your Label Gallery CD and double-click on the file START.EXE. 

2. Click on Install. A new window will open showing all Label Gallery editions. 
3. Click on the Label Gallery software you want to install. Follow the prompts. 
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Note: 
Make sure to select the appropriate installation type in the installation wizard. The same 
installation wizard is used for all Label Gallery editions. 

Installing Upgrades 

Install Label Gallery Edition Upgrade 

When you perform an edition upgrade, you want to upgrade to a more powerful Label Gallery 
edition; for example upgrade from Label Gallery Easy to Label Gallery Plus or Label Gallery 
Plus to Label Gallery TruePro. 
First you have to remove the old edition from the computer. During the removal of the old 
edition all user files (labels and forms) will remain on the hard drive and be accessible in the 
new edition. 
To upgrade your Label Gallery edition, do the following: 

1. Remove the existing edition of Label Gallery software. Open Add or Remove 
Programs from Control Panel, select Label Gallery from the list and click on the 
Remove button. 

2. Install the new edition on your computer. Follow the same instructions as for first-time 
installation. Refer to the chapter Installing Software. 

Note: 
Do not remove the existing edition until you have the activation document for the new 
edition ready. You have received the activation document from your vendor with the 
upgrade package. Before you will be able to use the new edition, you will have to 
activate it. 

Install Label Gallery Version Upgrade 

In a Label Gallery software version upgrade, you upgrade an older version, for example Label 
Gallery 4.0, to the latest version of 4.x. Before you upgrade your Label Gallery software, 
make sure you 

• Backup your Label Gallery files. 
• Do not remove the existing version from your desktop PC. 
• Check what Label Gallery edition you have. 

Note: 
To check your Label Gallery edition, look at the label on your CD jewel case or open 
Label Gallery software and go to Help/About in the menu. 

To upgrade your Label Gallery software version, do the following: 
1. Close the Label Gallery software on your desktop PC. 

Note: 
Make sure that all clients have logged off if you have Network edition. 

2. Put the Label Gallery CD in your CD-ROM drive. 
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3. Install the new version in the same folder where the old version is currently installed. 
The new version will replace the old one. 

4. Follow the prompts. 

Overview 

You can upgrade the Label Gallery software in two ways: You can either upgrade from an 
older version to the most current one or upgrade from one Label Gallery edition, for example 
Label Gallery Plus, to a more advanced edition, for example Label Gallery TruePro. 

System and Software Requirements 

Label Gallery Network Edition 

To run the Network Edition you need to fulfill the following: 
• All requirements for Label Gallery Non-Network edition. 
• Network interface card in each workstation. 
• Computer acting as a Label Gallery server. Any server operating system that allows 

file sharing with Windows system (any Windows, UNIX or Netware). 
• Each client must have granted full access (read, write, delete) to Label Gallery System 

folder on the server. 

Label Gallery Single User Edition 

To run the program you need at least the following: 
• Pentium based computer with at least 64 MB of free RAM. 
• One of the 32-bit Windows operating systems: Microsoft Windows 98 SE, ME, NT, 

2000, XP or 2003. 
• Hard disk with 50 to 205 MB of free disk space (depending on the installation 

options). 
• CD-ROM drive. 
• Support for OLE DB database drivers. Recent Windows operating systems have 

included OLE DB database drivers. If your operation system does not have the 
database support, the installation wizard will prompt you to install it. 

• Administrator rights to the local computer during installation. 

Pocket Label Gallery Edition 

To work with Pocket Label Gallery, you need to have the following: 
A) Desktop PC to design labels and forms with one of the following Windows operating 
systems: 

• Windows 98 or higher 
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• Windows NT with Service Pack 6 or  higher 
• Windows 2000 Professional with Service Pack 1 or higher 
• Windows XP 

B) Windows Mobile Device meeting the following requirements: 
• At least 8 MB RAM  
• Installed ActiveSync Version 3.5 or higher 
• One of the following Windows operating systems: 

• Pocket PC 2000, 2002 and 2003 
• WinCE 3.0 
• CE.NET 

Limitations of the Demo Mode 
The demo mode is enabled when you do not activate the software in time period of 30 days 
after the installation. Label Gallery software running in the demo mode has limited 
functionality. The major limitations of the Label Gallery demo mode are. 

Label Gallery 
Plus/Easy 

You can only print five (5) labels per print 
job. 
You can only define one variable field on 
the label you want to export (to Pocket 
Label Gallery, to SAP, to printer's memory 
or using other export possibilities.) 
If you continue running Label Gallery 
software in the demo mode, you will 
experience increasing delay at startup. 

GalleryForm* Three actions are executed on the button. 

GalleryWatch* Three actions are executed for the trigger 

GalleryMemMaster* Download to the printer is not enabled. 

GalleryData* Database tables with maximum twenty 
(20) records can be used. 

Pocket Label 
Gallery* 

You can print only one (1) variable field 
per label. 

You should use the DEMO version only to evaluate the software. Any commercial use of the 
DEMO software is prohibited. To obtain the full working version of Label Gallery software, 
you have to purchase and activate the software. 

Note: 
Products with an asterisk (*) are only available in Label Gallery TruePro edition. 
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Registering the Software 
At the end of the activation process, please fill out the registration form in the last step of the 
Product Activation process. If you have the access to the internet, the product can be activated 
on-line. You can also print out the registration form and send or fax it to the contact on the 
form. 
Registration is not required but you should register Label Gallery software to receive free 
occasional product newsletter. 
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Setting up LabelGallery Software 

Label Security 

Tracking Label Design and Printing 

Enable Revision History Comment 

To enable the revision history functionality, do the following: 
Select Options from Tools menu. 
Go to Settings tab. 
Tick the option Enable revision history logging. 

Note: 
If you want to be able to write a custom comment for each revision, also enable the 
option Prompt for revision history comment. 

4. Click on the OK button. 
Each time the label is saved, a revision note is saved with the label. 
To review the revision history data, do the following: 

1. Open your label file. 
2. Select Properties from File menu. 
3. Click on the Advanced button in the bottom of the dialog box to show the Revision 

History tab. 
4. Go to the Revision History tab. 
5. Review revision history data. 
6. Click on the OK button to close the dialog box. 

Use History Log to Track Label Printing 

Label Gallery software has the ability to log all information about printing action in the 
database for later review and reports. By default the logging is disabled. To be able to track 
label printing, do the following: 

1. Select the option Configure Log File in the Tools menu. 
2. Select the option Enable logging. 
3. Click on the OK button. 

To view at the log of printed labels, do the following: 
1. Select the option View Log File in the Tools menu. The table with the printing actions 

is displayed.  
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2. Browse the table, sort the records, filter the records (in the Advanced mode) and 
generate report file. 

Defining User Passwords and Permissions 

If you want to define access permissions for the users defined in Windows operating system 
or only define Label Gallery users, do the following (the following steps define Label Gallery 
users): 

1. Go to Tools and select Configure users. A new window will open. 

 
Dialog box for defining users and their permissions in the software 

2. Select the Configure Users option in the left pane. 
3. Click on the link 'Set authentication mode' in the right pane. The Authentication 

Mode dialog box will open. 
4. Select the option Mixed (Windows and Application authentication). Click on the OK 

button. 
Define new user by doing the following: 

1. Click on the button Add user in the main toolbar. For the username enter 'Label 
Gallery User' and define password for the user. 

2. Click on the OK button. 
Set up the profile and define user permissions by doing the following: 

1. Click on the Add Profile button in the main toolbar. 
2. Open the General tab and define the name of the profile, for example "My profile". 
3. Go to Permissions tab. 

Here you will define the access permissions to all applications that will be contained 
in this profile. 
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4. Expand the Label Gallery selection, then tick the options Label design, Label print and 
Label view. 

 
Definition of the permission granted by the profile 

5. Go to Members tab and add the user that you have added in previously. 

 
Add the user 'Label Gallery User' to the profile 'My Profile' 

6. Start Label Gallery Plus, log on with the new user and see how the limitations are 
applied to him. 
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Login 

Login dialog box is shown when you start the main program, if your administrator has 
enabled login in the settings. 
In order to use the labeling software the proper user name and password must be entered. 
Different users can have different privileges for usage of the program (print only, design only, 
view only or full access). 
 

User Interface 

Basic and Advanced User Interface 

Label Gallery software has two-level user interface. By default, basic user interface is enabled 
that makes the software easier to use for beginners and inexperienced users. 
Label Gallery in basic mode: 

• Hides the advanced tabs in dialog boxes. 
• Enables all wizards for frequent tasks in label design. 
• Hides the advanced Toolbars. 
• Shows large icons. 

To switch between basic and advanced modes, do the following: 
1. Click on the User Interface command in the Tools menu. 
2. Click on the command Set Basic Mode to enable basic mode or 

click on the command Set Advanced Mode to enable advanced mode. 
Note: 
You can also enable only some properties of the basic/advanced mode. Look at the 
other User Interface options in the Tools menu. 

Shortcuts 

You can quickly accomplish tasks you perform frequently by using shortcut keys - one or 
more keys you press on the keyboard to complete a task. Note that this is just a faster and 
more convenient way of choosing commands. Command itself is executed just as if it was 
selected from the menu or toolbar. 
Shortcut Command 
Delete Deletes selected element 

Shift + Delete Cut 

Ctrl + Insert Copy 

Shift + Insert Paste 

Alt + Undo 
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Backspace 

+ (numeric pad) Zoom In 

- (numeric pad) Zoom Out 

Alt + Shift + 
Backspace 

Redo 

Ctrl + T Rotate 90?counter-clockwise 

Ctrl + A Align 

Ctrl + X Cut 

Ctrl + C Copy 

Ctrl + V Paste 

Ctrl + Z Undo 

Ctrl + Y Redo 

Ctrl + N New 

Ctrl + O Open 

Ctrl + S Save 

Ctrl + P Print 

Ctrl + R Print Preview 

Ctrl + G Snap to grid 

Alt + F4 Exit 

Ctrl + move 
object with 
mouse 

Parallel moving of the object by main 
axes only. 

Alt + move 
object with 
mouse 

Object snaps to grid even if it is off. 

Ctrl + move 
object with 
cursor keys 

Fine tuning the position of the object. 

Shift + cursor 
keys 

Fine tuning the dimensions of the 
object, resize width and height in 
very small steps. 

Click Text icon 
 

in ToolBox, 

Dialog box for Text pops up. 
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then press Ctrl 
+ click on the 
label  

Click Graphics 
icon 

 
in ToolBox, 
then press Ctrl 
+ click on the 
label  

Dialog box for Graphics pops up 

Select variable 
from the list in 
toolbar, click 
Text icon 

 
in ToolBox, 
then click on 
the label  

Variable Quantity is automatically 
connected with text object and placed 
on the label. 

Select variable 
from the list in 
toolbar, click 
Graphics icon 

 
in ToolBox, 
then click on 
the label  

Variable Picture is automatically 
connected with graphics object and 
placed on the label. This is a great 
shortcut for using variable graphics, 
where filenames for pictures are 
received from database. 

Right-clicking 
the object  

Opens pop-up menu with shortcuts to 
commands. The content of the pop-
up menu greatly depends on where 
you clicked your mouse button and 
what was selected at that time. 

Enter (or F2) Dialog box with element's properties 
will open. 
 

F2 On-screen edit is enabled for text 
elements. 

Space + left-
click and 
dragging 

Freely move the label within Label 
Gallery window. If you want to 
change the view on the label, you do 
not need to separately scroll the label 
in up/down and left/right direction, 
but just grab it and move it to proper 
position. 
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Main Window 

The main window has many parts and functions. You can click specific parts of the screen-
shot image to see the description. 

 
Main window 

Mouse Wheel support 

If you have mouse, that has a wheel in place of the middle button, you can use it to speed-up 
zooming and scrolling a lot: 

• Turning the wheel, scrolls the label up or down. 
• Holding <SHIFT> and turning the wheel scrolls the label left or right. 
• Holding <CTRL> and turning the wheel, zooms the label in or out. 

Using the Keyboard and Mouse Effectively 

When selecting objects you can use <CTRL> key to adjust object's anchoring point by 
clicking the object placeholders. 
If you have a Wheel Mouse, you can use the wheel to scroll label up and down. Holding 
<CTRL> when rotating the wheel adjusts zoom factor, <SHIFT> scrolls label left or right. 
Double click the form name in the status bar starts GalleryForm and opens form that is 
attached to the label. 
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Double click on printer's name in status bar opens printer properties dialog box in which you 
can set various options regarding currently selected printer. If you hold <CTRL> while double 
clicking, printer setup dialog box is opened, in which you can select different printer. 
You can quickly move objects from one open label to another by simply dragging desired 
object to another window while holding <ALT>. If you want to copy objects instead, hold 
both <ALT> and <CTRL>. Note that you must have both label windows visible to do that. 
Different objects on label can be selected using the <TAB> and <SHIFT>+<TAB> keys. 
Pressing cursor keys while holding <Ctrl> key can move currently selected object. This can 
be used to fine-tune position of the object. Holding <SHIFT> while pressing cursor keys will 
resize the object. 
You can use the right mouse button almost anywhere on label to access most common options 
for that area/object. For example, if you click an object with right mouse button, a pop-up 
menu is displayed that contains options and actions that can be performed on selected object. 
Similarly clicking the other parts of label produces pop-up menu with options for that part of 
label. 
Multiple objects can be selected by holding <SHIFT> while clicking them. 
Use the element shortcuts in toolbars whenever possible. Each label element that can be 
connected to some Contents Provider, has a shortcut enabled to quickly access existing 
variables or define new ones. Click the element's shortcut handle for this shortcut. It is shown 
as a small arrow by the side of toolbar button: 

• In the Toolbox: , , ,  
and  

• in the Variable toolbar: . 

System folder 
The labeling application uses its system folder for storing files needed to run the program. 
The location of the folder varies depending on the Windows operating system used. 
On Windows 9X and Me the location is C:\Program Files\Sato\Gallery2\Bin\System, on 
Windows NT, 2000, XP the location is C:\Documents and Settings\All Users\Application 
Data\Sato\Gallery2\System. 

Note: 
Label Gallery Network clients used the System folder on the network server. It is also 
important that all clients have the full access to that System folder on the network 
server. 

It is vitally important to own the write access to this folder on your computer system and the 
right to write to and modify files in this folder. 
In these files user data and user rights are stored, as well as custom settings, variable trace 
logs, label usage logs, variable definition files (*.NVR), bar code standards, and file names 
GLOBALS.TDB. It stores the values of global variables. 
You should design the appropriate folder layout on disk for your label projects. With that in 
mind you can increase your work efficiency significantly and always know where certain 
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types of files are stored. The application also finds required elements faster this way. This is 
important with more demanding labels, which intensively use databases, pictures and forms. 
Make a separate folder for each project, you are building, e.g. Project1. Beneath this folder 
make subfolders Database (for databases), Forms (for forms) in Labels (for labels). Store 
appropriate files in each of these subfolders. 

Welcome Wizard 
When you start the labeling software a Welcome Wizard will be shown. It provides a quick 
access to most used commands when starting working on a label layout. 
Create a new label A blank label will be created and Label Setup Wizard will be started. 

You will be able to design a new label from a scratch. 

Open recently used 
label 

A list of recently used labels will be displayed to provide a quick 
access to commonly used labels. 

Open some other 
existing label 

A common Windows dialog box will open to let you browse for the 
appropriate label file. 
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Designing Labels 

Changing Printer Settings 

Changing Common Printer Settings 

When you start designing a label you tell Label Gallery software to what printer the label 
should be connected. Each label file remembers the printer settings for the selected printer 
driver on the label. 
As an example, you will change the printing speed and darkness. To change the printer 
settings, do the following: 
Go to File ?Printer Settings. The window with the printer settings will open. 
Open the Options tab. 
Change the Speed and Darkness options.  
Click on the OK button. 

Save the label by clicking the  button in the Standard toolbar or selecting the command 
Save in the File menu. 

 
Printer driver properties 

Note: 
Any changes in the printer settings dialog box will be saved to the label and applied to 
future print actions. 

You can also change the printer settings right before the label is printed. 
1. Select the Print command  in the File menu. 
2. Go to the Printer tab. 

This tab allows you to change the printer just before printing begins, but it also 
enables you to change common printer settings like speed, darkness and print 
direction. 

Note: 
Changes to the settings in the Printer tab will not be saved in the label but used only at 
print time. 
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Changing Dithering Options 

Dithering is a process of converting color or gray scale pictures to black and white pictures 
that can be printed on thermal printers. Thermal printers normally cannot print color images 
and can either print a dot on the label or not. There are no intermediate shades of grey. 
During the dithering process all colors and shades of grey in the picture are converted to black 
and white dots, creating the illusion of new colors and shades by varying the pattern of dots. 
Different shades of gray are produced by varying the patterns of black and white dots. There 
are no grey dots at all. In printing, dithering is usually called halftoning, and shades of gray 
are called halftones. 
To change the dithering settings, do the following: 

1. Go to File – Printer Settings. The window with the printer settings will open. 
2. Open the Dithering  tab. 
3. Change the Dithering type option to suit your needs. Look at the preview on the right 

side how you can expect the selected type to be applied on the label. 
4. Click on the OK button. 

5. Save the label by clicking the  button in the Standard toolbar or selecting the 
command Save in the File menu. 

 

Designing a Basic Label 

Add Variable Fields 

Create Date and Time Variable Fields 

Content of the variable field can be filled automatically with the date or time stamp from the 
computer clock or printer clock (for supported printer models). 

1. Click on the small arrow next to the  icon in the Toolbox to display a 
list of available variable types. 

2. Select New Date Field from the list. A dialog box with date properties opens. 

 
Creating new date variable field 

3. Leave everything as default and the date will be used on the label using the format as 
defined in your Windows operating system. 
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To place a time stamp on the label, do the following: 

1. Click on the small arrow next to the  icon in the Toolbox to display a 
list of available variable types. 

2. Select New Time Field from the list.  
3. Click on the Finish button. 
4. Click on the label where the counter should be placed. 

The new variable is linked to the text object on the label. 
The date and time fields are updated when you preview or print the label. In this example the 
values will come from the system clock of your computer. 

Create Keyboard Entry Variable Fields 

The content of a prompted field can be different for every print job. Before you print the label, 
you enter the value for the field. 

1. Click on the small arrow next to the  icon in the Toolbox to display a 
list of available variable types. 

2. Select New Keyboard Input from the list and click on the label where you want to 
position the object. 
A dialog box with the Variable Wizard will open. 

 
Creating new keyboard input variable field 

3. Type 'Enter product name' for the option Display this text to the print operator. 
4. Click on the Finish button. The cursor changes its shape to an arrow with a text 

object.  
5. Click on the label where you want to position the prompted field. 

The text object is placed on the label and linked to the new variable. 
Note: 
When you print the label, you will be prompted to enter the product name, which will 
be shown in preview on the label and on the printed label. 

Create Serialized Data Variable Fields (Counters) 

Now create a counter field on the label. The value of that variable field will automatically 
increase by one on every label. 

1. Click on the small arrow next to the  icon in the Toolbox to display a 
list of available variable types. 
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2. Select New Counter from the list. 
3. A dialog box with counter properties opens. 

 
Creating new counter variable field 

4. Leave everything as default so that the counter will always start from 1 and increase 
by one on each label.  

5. Click on the Finish button. 
6. Click on the label where the counter should be placed. 

The new variable is linked to the text object on the label. 
Note: 
Typically, the counter will increase by 1 on each label. For example, 1, 2, 3, 4, 5, etc. 
You can also define different incremental steps. 

Overview 

You may want to print the label on which the data changes for each label. Label Gallery 
software offers different variable fields (counters, date/time fields, operator's input from the 
keyboard) that you can use with text, graphics and bar code objects. 
For this example a new label was created. The following steps explain how to create a label 
that contains a prompted field, a counter and date/time fields. The captions in the following 
screenshots were added separately. 

 
The left label shows design mode, the right two labels are two consecutive labels from print preview 

Use Prefix or Suffix Options 

You can add a prefix and suffix to each variable field on the label. Both are added to the value 
when you preview and print the label. 

1. Click on the small arrow next to the  icon in the Toolbox to display a 
list of available variable types. 
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2. Select New Keyboard Input from the list.  
3. A dialog box with variable properties will open. 
4. Type the text 'Enter product weight' for the option Display this text to the print 

operator. Set the allowable characters to digits and click on the Next button. 
5. Enter ' kg' for the Suffix option. 

 
Defining the variable suffix 

6. Click on the Finish button. 
7. Click on the label where you want to position the prompted field. 

The text object is placed on the label and linked to the new variable. When you will 
preview or print the label, the suffix ' kg' will be appended to the entered value on the 
right side. 

Create a Basic Label 

Create a New Label 

To create a basic label, do the following: 
1. Open Label Gallery software (Plus, Easy or Free). 

2. Select New label under File menu or click on the icon  in the standard toolbar. 
Each time you create a new label, a Label Setup Wizard will start to help you setup the label 
and connect to the printer. 

Note: 
You can leave the Wizard at any time and accept the default settings for the label by 
clicking on the Finish button. 

Define Label and Page Dimensions 

1. If you want to use the label stock, select your choices in the window Select Stock.  
2. Click on the Next button. A new window will open to define the label dimensions 

manually. 
3. Leave the option Page Size on 'User defined' default and check Automatic Sizing.  
4. Click the Next button. A new window will open. 
5. Select label orientation and print direction.  
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Selecting label layout 

6. Click on the Next button. A new window will open. 
Enter 10 for label width and 7 for label height. 

Note: 
Dialog box differs from thermal and office printers.  
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Defining label dimensions 

Note: 
To change the unit of measure from centimeters to inches or other supported units, click 
on the button with unit of measure below the label preview in the dialog box. 

7. Click on the Finish button. New empty label will open. 

Enter Non-Changing Text 

1. Click on the  button in the Toolbox. The text cursor appears on the 
screen. 

 
Cursor for text object 

2. Move the cursor to the location on the label where you want to place the text object 
and click on the mouse button. 
The dialog box with object properties will open. 

3. Enter the text "SAMPLE" and click on the Finish button. 
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Entering content for text object 

4. Click on the text object to select the object. 
5. Change the font for the text object using the Text toolbar. 

Choose Arial font, 28 point size and bold style. 

  
Using format options in the text toolbox 

6. To change the position and size of the text object, select the text object and drag object 
with your mouse to the position where you want to have it. 

The screen should show the following: 
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The text object is placed on the label 

Insert Bar Codes 

Now you will add a non-changeable Code128 bar code on the label. 

1. To insert the bar code, click on the button in the Toolbox. 
2. Move the cursor to the desired position on the label and click on the mouse button.  
3. The dialog box with object properties will open. 
4. Enter the value 1234567890 for the bar code contents. 
5. Click on the Define button. 

Edit Bar Code dialog box opens. 
6. Make sure you select bar code Code128 and click on the OK button. 

 
Selecting bar code type 

7. Click on the Finish button to return to the label. 
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8. Change the position of the bar code by selecting the bar code and dragging it to the 
desired position. 

9. Change the object size by dragging the object handles. The handles are small 
rectangles surrounding the object when it is selected. 

The label should now show the following: 

 
Label with text and bar code objects 

Insert Pictures 

The Label Gallery software works with BMP, PCX, GIF, WMF, JPEG and many other 
popular graphic formats. 

1. To insert the picture, click on the   button in the Toolbox. 
2. Move the cursor to the desired position on the label and click on the mouse button. 
3. The Open dialog box will open allowing you to browse for your picture on your hard 

drive. Go to the folder Sample Graphics and select the picture LEISURE.WMF. Click 
on the Open button. 

The screen should show the following: 

 
Label with text, bar code and picture objects 

Save a Label 

Always save your label during the design process. To save a label, do the following:  

1. Select the  icon. 
2. Type in the name of the label. For example, enter 'label' for the name of the label. 
3. The name of the label is visible in the program caption. 
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Name of the label in the program caption 

Select a Printer 

1. Select the printer you want to use for label printing. 
Note: 
If you don’t find your printer on the list, refer to chapter Install Printer Driver for 
installation instructions. 

 
Selecting a printer 

2. Click on the Next button.  

Use Alignment Tools 

You have placed the objects on the label. Now you want to make sure they are aligned on the 
horizontal center of the label. You can align objects on the label by using the Align toolbar on 
the right side of the working window. 
To align objects on the label, do the following: 

1. Select all objects on the label. 

Note: 
The first object you select determines the alignment orientation for all selected objects. 

2. Choose a select arrow in the Toolbox and draw a frame around all objects to select all 
objects. 
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Selecting the objects on the label 

3. In the Align toolbar on the right, click on the  icon  to arrange the objects. 
The selected objects will be rearranged and positioned on the horizontal center on the 
label. 

Note: 
There are also other alignment commands available in the Align Toolbar. 

Note: 
You can also align the objects to the label grid. The option Snap to Grid is available in 
the View menu. 

Use Drawing Tools 

Now you will insert a line to separate a text object from other objects and a rectangle around 
the picture object. 

1. Select the  icon from Toolbox and move the cursor to the required 
starting point of the line. 

2. Press and hold down the mouse button while drawing the line. Move the mouse to the 
end position of the line and release the button. The Line object is placed on the label. 

3. Click on the  icon in the Toolbox and point the mouse to the upper 
left corner of the picture. 

4. Click and hold the mouse button while you stretch the rectangle to the lower right 
corner of the picture. 

5. To change the thickness of the vertical and horizontal line, double-click on the 
rectangle object to open its properties. Select the thickness you want and click on the 
Finish button. 

6. To edit the drawing object, double-click on the line or rectangle to open the dialog box 
with its properties. 

The label should show the following: 
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Label with fixed objects 

Overview 

In this section you will learn how to design a simple label file with fixed and variable objects. 
The variable objects can obtain values from several sources. You will learn how to: 

• Provide object values with a keyboard prompt. 
• Obtain object values from a database.  
• Preview the label on the screen. 
• Print the label. 

The label you create will look like this: 

 
Basic label 

Designing an RFID Smart Label 

Create RFID Smart Label 

1. Click on  button in the Standard toolbar. Label Setup Wizard will start. 
2. Select the printer that supports RFID smart label printing.  
3. Click on the Finish button. 

You will see that ‘RF Tag?command is enabled in the Toolbox on the left side of the 
Label Gallery software working window. 
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RF Tag is available for use 

Encode RF Tag 

The RF tags embedded into the label are usually of two types: ISO tags, which encode blocks 
of data; or UHF tags, which can encode one string of data. 

1. Click on the button  in the Toolbox to begin encoding the data. The 
RF Tag dialog box opens. 

 
Encoding contents for RF Tag 
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2. Select the type of the RF Tag you want to use from the list box on the top of the dialog 
box. 

3. Select the option Use RF Tag in label.  
Note: 
If you don’t select this option, the definition of tag content is saved but not sent to the 
printer. 

4. Go to the first available block in the section Data Blocks and click on the Data cell in 
the table.  

5. Type in the value you want to encode into this block. Repeat the process for other 
blocks. 

6. Click on the OK button. A schematic view of the RFID Tag antenna will open in the 
label background identifying the definition of the RFID data on the label. 

 
RFID Tag antenna in the background 

7. You can continue designing the smart label with non-RFID data as described in the 
previous sections. 

Whenever you print the label, the RFID data will be sent to the printer. The printer prints the 
RFID smart label and programs the RFID tag embedded into the label at the same. 

Note: 
Label Gallery can work with Unique RF Tag numbers. Each RFID tag has embedded a 
unique serial number. Some printers can read the Unique RF Tag number and it can be 
used on the label linked with some label objects. 

Overview 

Radio frequency identification (RFID) refers to technologies that use radio waves to 
automatically identify individual or groups of items. Label Gallery software and 
GalleryDriver support programming and printing of RFID tags embedded in a label.  

Note: 
You can use RFID functionality in Label Gallery software only if you have installed a 
GalleryDriver with RFID support. Make sure you install the GalleryDriver of your 
RFID printer before you design and print an RFID smart label. 
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Support for RF Tags 

The concept of RFID (Radio Frequency IDentification) can be simplified to that of an 
electronic bar code. First emerging in the 1980s, RFID was primarily used to track objects in 
industrial environments where bar codes were unable to sustain the harsh surroundings. 
Today, RFID is being used to authenticate official memorabilia, track proprietary assets, 
automate access control and has many more additional fields of usage. 

 
RF Tag dialog box 

Some thermal printers have the ability to program a RFID tag at the same time as they are 
printing the label. Two different technologies and their encoding methods are joined on the 
same label. Of course a label must have embedded a RF tag. The tag is paper thin, flexible 
and small in size which allows it to be placed inconspicuously under the label. It consists of 
an etched antenna and a tiny chip that can store ID number or your custom data in larger 
quantities. This contrasts with a bar code label, which does not store any enhanced 
information, but merely some code number. 
RF tag data encoding options can be set in this dialog box. 
Use RF Tag in label: Enable this option if you want to program the tag at the same time as 
the label is printed. If the option is not selected, no RF data is sent to the printer, but the 
definition is remembered for next time. 
Type: Select the type of RF tag you want to use with your printer. The list of available tags 
change with the selected printer. Not all tag types are always available. You must use 
GalleryDriver to be able to use RF programming. It also depends on each printer model what 
kind of RF ID tags can be used with it. There are generally two types of tags: 
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• ISO tags (TagIt, iCode, ISO...): These are block oriented tags. The data can be 
encoded in multiple blocks. 

• UHF tags (ePC): The data is encoded in one block of data. 
 
Tag Settings: This section provides the information about the selected tag type. 

Number of blocks: The number of blocks that are available in the RF tag. 
Reserved blocks: The number of blocks that cannot be accessed and used.  
Block size: The size of each block (in bytes). 
Unique RF Tag: If you have the printer and/or the tag type that can provide you with the 
Unique Tag ID, this flag will be set to Yes. Each tag has a unique ID encoded already in 
the production line. If your printer can read this information from the tag, you can use it 
with the label elements. When the Unique Tag ID is supported, you can connect it with 
the label elements using RFID Unique Tag ID contents provider. 
For example: The printer scans Unique Tag ID, remembers it and prints it on the label 
encoded in a bar code element. 
Antenna offset: To achieve better programming accuracy of the tags here is the option to 
define the offset for the antenna in the printer. This is the distance from the edge of the 
label to the embedded tag. This option will help you program the tags more accurately. 
Number of retries: The number of times the printer will try to program the tag if first 
attempt fails. The parameter is sent to the printer with the rest of the data. 

Data Blocks: This section allows you to provide data values for the RF tag. The sections has 
different options available for different tag types (UHF or ISO). 
For UHF tags 

Data type: Data type of the selected tag can be specified here. 
Data source: Incoming data that is encoded in the tag can be fixed value or acquired 
from some variable, defined in the label. 
Data size: The currently used data is previewed here. You can see the amount of space 
still available in the tag. The occupancy of the tag is seen graphically with growing bar 
and numerically with the digit, explaining the number of already used bytes. 
Block locked: If you set the block as locked, the data will be permanently encoded into 
the tag. You will not be able to erase this block to re-program it with some other value. 
Use this option with caution! 

For ISO tags 
The blocks that are dimmed and unaccessible are reserved blocks that cannot be used. 
Block Number: The successive number of block in the tag. 
Data source: Select where the data block will receive the value from. It can be Fixed, 
where you will manually type in the value or can be Variable, where the value is acquired 
from some variable defined in the label. 
Data: Type in the tag value manually, if the selected data type is Fixed. Select the 
variable defined in the label, if the selected data type is Variable. If your variable length 
is greater than the block size, the next block will automatically be reserved for the data. 



Label Gallery User Guide 

54 

Size: The currently used data is previewed here. You can see the amount of space still 
available in the tag. The occupancy of the tag is seen graphically with growing bar and 
numerically with the digit, explaining the number of already used bytes. 
Data type: The data can be encoded as ASCII string or as HEX encoded string. 
Locked: If you set the block as locked, the data will be permanently encoded into the tag. 
You will not be able to erase this block to re-program it with some other value. Use this 
option with caution! 

 

Using Advanced Functionality 

Creating a Label with EAN.UCC 128 Compliance 

Add Content to EAN.UCC 128 Using EAN.UCC 128 Wizard 

Use the EAN.UCC 128 Wizard to help you add the necessary Application Identifiers (AI) in 
the bar code. Complete the following steps with the wizard: 

1. Select 10 Batch or Lot number.  

 
Selecting Application Identifier from the list 

2. Click on the Next button. 
3. Select Fixed and click on the Next button. 
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4. Enter the sample data, for example '12345'. 
5. Click on the Next button. A dialog box showing all AI contained in this bar code will 

open. 
6. Click on the Add button to start adding a new AI. 

For example, select AI 21 (Serial Number). Repeat steps from 1 to 5 above. 

 
Two Application Identifiers are defined 

7. When you are satisfied with the designed AI and their positions within the bar code, 
click on the Finish button. 

The EAN.UCC 128 bar code is placed on the label. 

Edit Bar Code EAN.UCC 128 

 
The designed label with EAN.UCC 128 bar code 

To define the EAN.UCC 128 bar code, you first select this bar code type and assign a value to 
it. 

1. Click on the small arrow button next to the  button in the Toolbox. 
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2. Select Fixed Bar Code in the context menu. 

 
Creating a fixed bar code 

3. Move the cursor to the location on the label where you want to place the bar code 
object and click on the mouse button.  

4. The wizard with object properties will open. 
5. Click on the button Define. The dialog box Edit Bar Code will open. 
6. Expand the group EAN.UPC and select the bar code EAN.UCC 128. 
7. Click on the OK button to go back to the Bar Code dialog box. 
8. Click on the Next button. 

The EAN.UCC 128 Wizard will open. 

Controlling Cutter in the Printer 

If you have a thermal printer equipped with the cutter, you can control the cutter action from 
Label Gallery software. You must use GalleryDriver for your thermal printer if you want to 
control the installed cutter. To set up the cutter control, do the following: 

1. Select the option Label Setup in the File menu. 
2. Go to the Cutter Settings tab. 
3. Select the option Enable cutter. 
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Enabling cutter functionality 

Note: 
Label Gallery Easy edition can control the cutter. However, you cannot use the Label 
Setup dialog box. Instead you must define the cutter parameters in the properties of the 
GalleryDriver printer driver. Please refer to the Label Gallery Easy manual  for 
instructions how to set up cutter. 

Defining Label Batch Printing and Using Header and Tail Labels 

Label batch refers to a group of labels that have some property in common. The purpose of 
identifying label batch is to execute the actions and to enclose each label batch with header 
and tail label. The header and tail labels are printed in front of the first label in the batch 
(header label) and after the last label in the batch (tail label). They can be used as page 
separators and can include additional information for the label operators. To enable label 
batch printing, do the following: 

1. Select the option Label Setup in the File menu. The Label Setup Wizard will open 
2. Select the option Open the advanced options dialog box and click on the button 

Finish. The main Label Setup dialog box will open. 
3. Go to the tab Batch Printing. 
4. Click on the button Advanced in the bottom part of the dialog box. The Advanced tab 

will open. 
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5. Look at the Label Batch Definition sections. If your label batch will contain 5 labels, 
enable the option Fixed number of labels and type 5 in the combo box in the right. 

 
Setting up label batch  

6. To enclose the main labels with header and/or tail labels, tick the option Use header 
label and/or Use tail label. 

Header and tail label are stored in the same label file, but you can still design them as separate 
labels. Access to header and tail label from the View menu where you can enable and disable 
view on the these labels. 

Designing Double-Sided Label 

Label Gallery software (Dynamic edition) supports double side printing for office printers 
(inkjet, laser...) and for thermal printers. The option is enabled in the Label Setup dialog box, 
Printer tab. Look at the option Double-sided printing. 

Note: 
The option is available only, when the used printer driver supports double-sided 
printing. 

As soon as you enable this option, the option Label Side in the View menu becomes available. 
Use it to switch between front and back sides of the label. The identification of the current 
page is also visible in the status line at the bottom of the window. 
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When printing to office printer, these two pages are always printed one after another. They are 
sent to the printer one after another so make sure you enable duplex functionality in the 
printer driver. 
When printing to thermal printer, printer driver GalleryDriver will take care of proper label 
processing and printing. You need to use the appropriate GalleryDriver to enable double-
sided functionality. 

Multicolor printing 

Some thermal printers support multicolor printing. They use multiple heads, each head for a 
ribbon of a different color. The colors for each printer head are customizable and can be 
defined in the printer driver. Each print head is assigned a color that matches the used ribbon. 
The same colors become available in the labeling software. For multicolor printing to work 
you need to use the appropriate GalleryDriver. 
Color palette synchronizes the available colors with settings in the printer driver. All colors 
you have defined in the printer driver are retrieved in the labeling software and made 
available for color selection. Color palette, color selection dialog box and label setup dialog 
box all display only the available colors from the printer. Each label element can then easily 
be assigned some of the available colors. The element is then printed using that color. More 
than one color cannot be used with a single label element. 
When you use color images on the label, their appearance on the label changes. They cannot 
be printed in more colors than supported by the printer. The images are not displayed in full 
color. Each image is converted to monochrome graphics and previewed on the label as such. 
Conversion from color to monochrome graphics is done using dithering setting in the driver. 
You can assign the image one color and thus the print head where the image will be printed. 
The colors on the label identify which printer head will be used for printing the elements. 
 

Setting up Stock Manager to List Commonly Used Labels 

When you create a new label, you can base the new label on some pre-designed label format 
referred to as stock, or you can design the new label from the scratch. Label Gallery software 
comes with a library of pre-defined stocks, based on the labels from different manufacturers. 
You can also add the definition of your own labels into the library by using Label Gallery 
Stock Management. To open Stock Management, do the following: 

1. Select the option Stock Management in the File menu. A new window will open 
showing all defined stocks listed in a table.  

2. Under the Stock type option, select the group from the combo box for which you wish 
to show the stocks. The table will contain stocks from this group only. 

Define your own group by doing the following: 
1. Click on the ellipsis button. The dialog box of Stock Types will open. 
2. Click on the Add button and provide the name of the group. Click on Save and Close. 
3. Select your new group and click on the button New in the bottom part of the dialog 

box. The stock definition dialog box opens. 
4. Open the General tab and define the identification properties of the stock. 
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5. Open the Dimensions tab and define the width and height of the label.  
6. Click on the OK button. 

The stock will be saved in the library and available for selection whenever you will create a 
new label. 

Tracing Variable Values 

Each value of the variables can be traced and logged into the log file. 
By default the tracing functionality is disabled. 
To enable tracing, do the followin: 

1. Select Variable Trace Setup from Data menu. 
2. Select the variables you want to trace. 

Note: 
By default, values for all variables on the label are traced. 

3. Select Configure Log File from Tools menu. 
4. Enable logging functionality. 
5. When you will print labels, the values for variables as were used on the label are saved 

to the log file. 

Using Contents Mask 

Contents mask is very useful when you must display the input data differently on the label. 
With contents mask you can simply reformat the data to suit your needs. 
For example, you must use differently formatted human interpretation text below bar code 
than the data is formatted in the bar code. You do not want to define two variables for this 
purpose and enter the similar data twice. 
The mask character will be replaced by the actual data and any other used character will be 
used as-is. If the current bar code value is 
"AD951" 
and the contents mask is 
"**C - ** /*/" 
the resulting output will be 
"ADC - 95 /1/" 
Powerful formatting structures can be defined using Contents mask, but it is only available 
with bar codes that allow custom formatting of the human interpretation. You should also 
make sure to print bar codes as graphics, otherwise the contents mask is not available. 

Note: 
If your data contains the asterisk "*" character, then you will have to change the default 
mask character to something else. It should be a unique value, not appearing anywhere 
in the data. 

The contents mask functionality is available with Text and Bar code objects. 
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Using Expression Builder 

The labeling software has a simple text editor built-in. You can use it to design your own 
simple VB Scripts or .JOB batch files with GalleryCommands. 
The Expression builder is a programming text editor with constant access to command 
reference of the script language you are currently using. The Expression Builder can be used 
with Visual Basic Script and with GalleryCommands. 
The Expression Builder lets you edit your scripts and expressions with ease. The Load and 
Save buttons allow you to import / export Visual Basic scripts from / to external text files. 
The builder uses standard shortcuts for positioning of the cursor and working with text files. 
Available are also standard Search and Replace shortcuts (Ctrl + F, Ctrl + R). 
The working window is divided into four parts. 

Category This section contains the groups of available 
commands, functions and operators. Similar 
objects have been grouped together for easier 
identification and faster search. 
The groups are displayed as tree-view. Select 
the main group name to display all its 
contents into the Name section. Or you can 
click the plus sign in front of the group name 
(if available) to display all defined sub-
groups. Then select the sub-group name to 
display only its contents. 

Name This section will display the contents of the 
selected group in the Category section. All 
available commands, functions, operators etc. 
will be listed here. If you select one of them 
its properties will be displayed in the 
Description section. If you want to insert the 
selected operands into the Expression field 
double click its name or click the Insert 
button. 

Expression This section is the main workplace of the 
Expression Builder. Use it to write and 
modify the script your are working on. 

Description This section displays the name, sample use 
and description of the currently selected 
operand in Name section. 
You will get an idea how the current operand 
should be used. 

Script Help: button will open the help file with the detailed reference of the currently used 
script (Visual Basic Script or GalleryCommands). Click it to find out more about the 
command you are working with. 
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Using Label Inspector 

Label Inspector is a tool for advanced element and data manipulation on the label. It is used 
for overview of label's structure and modifying label components, all element's properties can 
be simply modified from Label Inspector. You can of course still double click the element and 
change its properties from dialog box, but for smaller changes it is much quicker to change 
them in Label Inspector. Besides functionality you were used to earlier, Label Inspector 
brings some entirely new features, not available in previously. 
Now you can change properties of several selected elements at the same time. If elements are 
of the same type, for example, all texts, you will be able to change their every property. If 
elements are of different types, for example, one text, one bar code symbol and one rectangle, 
only the properties common to all elements could be changed. 
With Label Inspector you change some element's properties that are not accessible otherwise. 
Each element can have its own name, so you can distinguish between them. Whenever you 
select the element on the label, it will be highlighted in the list of elements within Label 
Inspector and its properties will be displayed in the bottom part of the Inspector (Properties 
section). 
Label Inspector can be used to change the current view of the label elements, variables, 
functions and databases. The following views are available, the first on being the default one. 

• View by Objects: 
All label elements are listed alphabetically by their type. First listed are text elements, 
then paragraph, bar code, graphics, rectangle and line elements. You have probably 
noted this is the same order of elements as they appear in the Toolbox. When you 
select one or more elements in the upper part of the Inspector, its (their) properties are 
displayed in the bottom part of Inspector. You can interactively change them and 
changes will be reflected automatically on the label. You can right-click any element 
and quickly access frequently used commands from the drop-down menu. You can 
find out to which variable some element is connected to by clicking the plus sign in 
front of the element's name. If it is not fixed, the view will be expanded and variable 
name displayed. 

• View by Variables: 
All variables used on the label are listed here. They can be either prompt (their value 
is typed-in by the user at print time), database (acquired from database fields) or 
function-generated variables. If you click the plus sign in front of variable's name, the 
view will be expanded. You will be able to review from where the variable gets its 
data (database, function) and to which element(s) it is connected to. At the top of the 
upper section you can define a new variable. You can right-click any variable name 
and quickly access frequently used commands from the drop-down menu.  

• View by Functions: 
All functions used on the label are listed here. If you click the plus sign in front of 
function's name, the view will be expanded. You will be able to review which are 
input and output variables for the function. At the top of the upper section you can 
define a new function. You can right-click any function and variable name to quickly 
access frequently used commands from the drop-down menu. 

• View by Databases: 
All databases used on the label are listed here. If you click the plus sign in front of 
database's name, the view will be expanded. You will be able to review which are 
output variables from the database. At the top of the upper section you can define a 
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new database. You can right-click any function and variable name to quickly access 
frequently used commands from the drop-down menu. 

• View as List: 
This view is similar to View by objects with one difference. Not only objects are listed 
here, but also all variables, functions and databases. You can right-click any name to 
quickly access frequently used commands from the drop-down menu. 

The rightmost button Inspector properties is used to define the default behavior: should the 
view to Inspector's elements be expanded by default or not. If the elements are expanded then 
all the properties for all of them are visible. If they are not expanded, you will have to 
manually expand the view of the element, you are interested in. 
The default position of the Label Inspector is a docked position beside Toolbox on the left 
side of the working window. This position can be changed at any time, just drag Label 
Inspector to some other location. You can use it in a floating state, when it is not docked in 
the application, but positioned above or next to it. When it is in this form, you can freely 
change its size, simply grab it by the edge or the corner and resize it in appropriate direction. 
 

Using Pictures from the Memory Card 

To select the picture from the memory card, do the following: 
1. Open the label where you want to use the pictures from the memory card. 
2. Make sure the printer has inserted the memory card that contains the pictures. 

Note: 
The application GalleryMemMaster must be used to fill the content of the memory card. 

3. Select the command Printer Settings in the File menu. 
4. Go to Printer Memory tab. 
5. Look at the Slot where you have inserted your memory card in the printer. 
6. Change the Slot Type to Memory Card. 
7. Select the appropriate .MMF file, created by the application GalleryMemMaster. 
8. Close all dialog boxes. 
9. Select the Picture object in toolbox, then click on the label. 
10. Browse to the picture on the disk that you want to use. 

Note: 
This is the same picture as you have downloaded to the memory card. You need to 
insert it from the disk for previewing purposes only. When the label is printed, the 
picture already stored in the memory card will be used. 

11. Tick the option Picture is stored on the memory card. 
12. Click on the OK button. 
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Using Label Setup Wizard 

Defining Label Dimensions 

Here you can enter the label dimensions. 

Note: 
The values for dimensions are entered automatically if you selected the label stock in 
the previous step. 

 
Label setup Wizard - defining the label format 

Width, height: Define the label dimensions. 
Margins: Define the label margins. 
Rows, columns: Define the number of labels in horizontal and vertical directions. This option 
is commonly used with office printers. 
Gaps: Define the gaps between the labels. 

Note: 
Define gaps only if you have changed rows and columns option. If you have rolls of 
labels, the gaps between the labels are auto-identified by the gap sensor in the printer. 

Unit of measure: Change the unit of measure you want to use. 
When you are satisfied with the label dimensions, click on the Finish button to close the 
Label setup wizard. 
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Defining the Page Size 

 
Label setup Wizard - choosing Label Dimensions 

Select the page size for your labels. This step is only necessary for the office printers. 
Automatic Sizing: Tick this option, Label Gallery and GalleryDriver will negotiate about the 
label dimensions. 
Click on the Next button to continue with the next step. 
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Selecting Label Layout 

 
Selecting label layout 

Orientation: Select the label orientation. Look at the screen and printer layouts for 
suggestion how the label will really be printed from the printer. 
Print directions: Tick the option Rotated to rotate the label for 180 degrees, when printed. 
Click on the Next button to continue with the next step. 
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Stock 

 
Label setup Wizard - selecting Label Stock 

If you use one of the standard predefined label formats, you can specify it here. 
Stock Type: Select the type of stock. 
Stock name: Select the stock from the list. 
Stock information: The information about label dimensions, printer settings, background 
images as defined by the selected stock. 
Label linked to stock: If you enable this option, you cannot change the dimensions of the 
label, because the stocks locks the dimensions. 

Note: 
Using pre-defined stocks simplifies the process of label creation as you do not have to 
define the label dimensions manually. 

Click on the Next button to continue with the next step. 
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Selecting Printer 

 
Label setup Wizard - Selecting printer 

Select desired printer and optionally click Properties button if you want to set the printer 
parameters. Print setup dialog box is shown, allowing you to set the printer parameters such 
as print speed, print darkness and print direction. Note that this is standard Widows printer 
setup dialog box and its options may differ from printer to printer as it is based on the printer 
driver. 
If the check box Always use default printer is checked, the default window's printer and its 
settings will be used always when opening this label. 
Click the Next button to continue with the next step. 

Using Label Setup Wizard 

Label Setup Wizard offers defining dimensions of the label and changing printer setup. It 
consists of a few simple steps. Click on the Related Topics button for more information. 

Using Toolbars 

Using Database Toolbar 

 
First field shows the list of currently active databases. It allows you to browse through the 
attached databases. 



Designing Labels 

69 

 List box lists the links to the databases that are available in the label. 

 Define a link to new database using Database wizard. The Database 
wizard will guide you through the necessary steps to link database on the 
label. The result will be database fields available as variables. 

 Define new link to the database manually. 

 Edit the properties of the selected link to the database. You can change 
the database driver, select which records will be printed and define if 
quantity of the labels comes from the database. 

 Delete the selected link to the database. 
Note: 
Make sure that database fields are not used anywhere on the label, linked 
to objects or used in the functions. Otherwise the link cannot be removed. 
 If you are not sure, where the database fields are used, use the Label 
Inspector to find that out. 

 Click on this button to open the database table in database management 
application GalleryData. 

 Database navigator buttons can be used to move through the records in 
the database. Use these buttons to see how data from different records will 
be used on the label. You can quickly verify if the objects fit on the label. 

Note: 
The buttons are accessible only when you have enabled Data view 
on the label and when record selection in the properties of database 
link is disabled. 

Using Design Toolbar 

The design toolbar is used for: 
• Changing color of the objects. 
• Aligning objects. 
• Rotating objects. 
• Arranging objects. 

Using Printing Toolbar 

 

 Preview labels on-screen. 

 Print the current label. 

 Test print the current label. 

 Print the label using the form generated in the application GalleryForm. 
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Note: 
The label must be set up to print labels through the form. Also the form 
file must be prepared in advance. 

 Open the dialog box with printer properties. You can change the settings in 
the printer driver. 

 Quickly change the print direction of the label. 

 

Using Standard Toolbar 

Click on the icons in the standard toolbar will execute the following actions: 

 Create new label. 

 Open existing label. 

 Save currently opened label. 

 Cut the selected objects to clipboard. 

 Copy the selected objects to clipboard. 

 Paste the objects from the clipboard. 

 Undo last action. 

 Redo last action. 

 Access to the print functionality. Click on the small arrow for more 
commands. 

 Access to the zoom functionality. Click on the small arrow for more 
commands. 

 Access to the view functionality. Click on the small arrow for more 
commands. 

 Access to the variables. Click on the small arrow for more commands. 

 Access to the databases. Click on the small arrow for more commands. 

 Open the help file. 

 

Using Text Toolbar 

You can use text toolbar to quickly format the text objects on the label. 
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Here is how: 
1. First select it the text object by clicking it. 
2. Click the appropriate shortcut button in the text toolbar. 
3. To change the font, select the appropriate font from the list in the list box. 

Note: 
You can limit the display of fonts in the list. You can list all fonts on the system, only 
graphic fonts (truetype, opentype, type1, bitmap Windows fonts) or only thermal printer 
resident fonts. Click on the two icons next to the list of fonts. 

4. To change the size of the text, click on the list with font sizes and select appropriate 
size. You can also click on the buttons  and  that will enlarge/reduce the size of 
the font to the next step. 

Note: 
You can change the fonts size also directly on the label by resizing the text element with 
a mouse. 

5. To format the text bold, italic or underline, click on the appropriate formatting buttons. 

 Formats the selected text in bold style. 

 Formats the selected text in italic style. 

 Formats the selected text in underline style.

6. To change the alignment of the text object, click on the appropriate alignment buttons. 
Note: 
These buttons are accessible only for multi-line text objects. 

 Aligns text to the left edge. 

 Aligns text to the horizontal center.

 Aligns text to the right edge. 

 

Using Toolbox 

To use the toolbox, do the following: 
1. Click on the icon in the toolbox to select the object. 
2. Move the mouse over the label. See how the cursors has changed. 
3. Click on the label where you want to place the selected object. 

Some objects have additional shortcut on the right side of the icon. Using this shortcut you 
can quickly create a new object with fixed content, create a new variable and connect it to the 
selected object or connect the object to one already defined variable. 
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Using Variable Toolbar 

 
The list box contains the variables available on the label. If you have selected some variable 
object, the list box displays variable linked to that object. If no object is selected, selecting a 
variable then clicking on the label places new text object and links it to the variable. 

 Create new variable using the Variable wizard. If you click on the small 
arrow, you can specify the type of the new variable. 

 Create new variable manually. 

 Edit the properties of the selected variable. 
Note: 
If you select the variable object, the variable linked to the object will 
be automatically listed in the list. 

 Delete the selected variable. 
Note: 
If you want to delete the variable, you must not use it on the label 
linked to label objects or used in functions. 

 Disconnects the variable from the object. The object becomes fixed, but will 
preserve the formatting. 
The number of the characters in the object will be equal to the length of the 
variable. This might be useful when you are changing the database on the 
label and want to conserve current position and format of the objects. When 
you re-connect the other database, you can simply link the objects to new 
variables. 

 Access to the Label Gallery Functions dialog box. If you click on the small 
arrow, you can select which new function you want to create. 

There are several methods to connect a variable to some label element that should contain 
variable values. 

• If you have the element already positioned on the label, select it, then choose the 
appropriate variable in the list. 

• If the element is not already on the label, you can first select the variable in the list and 
then click the label where you want the element positioned. Text element will appear 
there and will be connected to the chosen variable. 

• If you want any other element (and not text) connected to the variable, you can first 
select the variable in the list, then click the desired element in the Toolbox and then 
click the label. 

• You can click on the small arrow button next to the object icon in the toolbox, select 
the option Use Existing Variable, select the variable from the list and click on the 
label. 

Variable toolbar always shows the name of the variable, which is attached to the current 
selected element. If there are two or more elements selected, and do not have the same 
variable attached to it, then the variable combo box is empty. 
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Using Zoom Toolbar 

 Zoom in: This command increases the 
selected element or part of the element. 

 Zoom out: This command decreases the 
selected element or part of the element. 

 Factor: You can define your own factor of 
zoom (in %). 

 Zoom to label: You will see the entire label 
on the screen. 

 Zoom to page: You will see the entire page 
on the screen. 

 Zoom to objects: You will see all the objects 
on the screen. 

Note: 
To be able to zoom into the label at custom zoom factor, you can click on the  
button and the draw a frame on the section of the label you want to zoom in. 

Working with Objects 

Defining Objects 

Defining Bar Code Object 

To place the bar code object on the label, do the following: 
1. Click on the Bar Code icon in the Toolbox. 
2. Click the position on the label, where you want to place the object. 

Bar Code Wizard dialog box will open. 
3. Define the contents for the bar code object. 
4. Click on the Next button to advance to the next step of the wizard. 
5. Follow on-screen instructions in the next steps. 
6. Click on the Finish button. 

Note: 
Should you later want to edit the object, select it then double-click it. The wizard with 
properties appears. 

Defining Ellipse Object 

To place the ellipse object on the label, do the following: 
1. Click on the Ellipse icon in the Toolbox. 
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2. Click the position on the label, where you want the upper-left position of the object to 
be set. 

3. Drag to bottom-right direction until the object size is as requested. 
4. The other method of positioning the object on the label is simply selecting the Ellipse 

tool and then clicking the label. A default-sized ellipse will appear and you can resize 
it using handles around the object. 

Note: 
If you want to draw a circle, grab a handle a on one of the ellipse corners, 
simultaneously press and hold Shift key, then resize the ellipse. A circle will be drawn. 
For more useful shortcuts available in the software refer to the chapter Shortcuts. 

4. To move a ellipse to a different position simply select it and drag it elsewhere on the 
label. 

Defining Inverse Object 

To place the inverse object on the label, do the following: 
1. Click on the Inverse icon in the Toolbox. 
2. Click the position on the label, where you want the upper-left position of the object to 

be set. 
3. Drag to bottom-right direction until the object size is as requested. 

Note: 
If you want to draw a square, grab a handle a on one of the rectangle corners, 
simultaneously press and hold Shift key, then resize the rectangle. A square will be 
drawn. For more useful shortcuts available in the software refer to the chapter 
Shortcuts. 

4. To move a inverse to a different position simply select it and drag it elsewhere on the 
label. 

Defining Line Object 

To place the line object on the label, do the following: 
1. Click on the Line object in the Toolbox. 
2. Define the line starting point by clicking the mouse at the start position. 
3. Move the cursor to the end point, while holding down the mouse button. 

A line will be drawn from the left to right side of the label. 

Note: 
If you need to draw a vertical line, just click for starting point then drag the cursor in the 
up-down direction. 

Defining Picture Object 

To place the picture object on the label, do the following: 
1. Click on the Picture object in the Toolbox. 
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2. Click on the label, where you want to place the picture. 
The Open dialog box opens. 

3. Browse for the picture on the hard disk, then click on the Open button. 
Note: 
Should you later want to edit the object, select it then double-click it. The wizard or 
dialog box with properties appears. 

Defining Rectangle Object 

To place the rectangle object on the label, do the following: 
1. Click on the Rectangle icon in the Toolbox. 
2. Click the position on the label, where you want the upper-left position of the object to 

be set. 
3. Drag to bottom-right direction until the object size is as requested. 
4. The other method of positioning the rectangle object on the label is simply selecting 

the Rectangle tool and then clicking the label. A default-sized rectangle will appear 
and you can resize it using handles around the object. 

Note: 
If you want to draw a square, grab a handle a on one of the rectangle corners, 
simultaneously press and hold Shift key, then resize the rectangle. A square will be 
drawn. For more useful shortcuts available in the software refer to the chapter 
Shortcuts. 

4. To move a rectangle to a different position simply select it and drag it elsewhere on 
the label. 

Note: 
Should you later want to edit the object, select it then double-click it. The dialog box 
with properties appears. 

Defining Rich Text Box (RTF) Object 

The Rich Text Box object enables you to format text in any kind of font types and styles. To 
create a Rich Text Box object, do the following: 

1. Click on the  button in the Toolbox. The rich text box cursor appears 
on the screen.  

2. Move the cursor to the location on the label where you want to place the text box 
object and click on the mouse button. The rich text editor will open.  

3. Enter the content.  
4. Use the text toolbar in the editor to format the characters. 
5. Click on the OK button. The Rich Text Box object is placed on the label. 
6. Double click the Rich Text Box to open its properties.  
7. Go to the Detailed tab and select the option Best fit. 
8. Click on the OK button. 

The text size in the Rich Text Box object automatically changes when you resize it. 
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Defining Text Box Object 

The Text Box object enables you to use free-flow text inside the designed Text Box frame 
without being limited to a one-line text. To create a Text Box object, do the following: 

1. Click on the  button in the Toolbox. The text box cursor appears on 
the screen.  

2. Move the cursor to the location on the label where you want to place the text box 
object and click on the mouse button. The properties of the object will open.  

3. Open the Value tab and type in the text content. 

  
Entering value for Text Box object 

4. Click on the OK button. The Text Box object is placed on the label. 
5. Double click the Text Box to open its properties.  
6. Go to the Detailed tab and select the option Best fit. 

Note: 
When you change the size of the Text Box frame, the content will automatically align to 
the new size. 
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All three text objects are available in Label Gallery software 

Defining Text Object 

To place the text object on the label, do the following: 
1. Click on the Text icon in the Toolbox. 
2. Click the position on the label, where you want to place the object. 

Text Wizard dialog box will open. 
3. Define the contents for the text object. 
4. Click on the Next button to advance to the next step of the wizard. 
5. Follow on-screen instructions in the next steps. 
6. Click on the Finish button. 

Note: 
Should you later want to edit the object, select it then double-click it. The wizard with 
properties appears. 

 

Selecting Bar Code Type 

Settings for Advanced Bar Codes 

DataMatrix Bar Code 
General tab 
Y expansion factor 
This option defines the height of the bar code symbol. 
Aspect Ratio 
It is the ratio between number of columns and number of rows. Enter the wanted value in the 
fields. 
Details tab 
ECC Type 
Error Correction Codes define the security level. You can select one from the standard levels 
in the pull-down menu. 

Format ID 
This option defines which character set will be used in the bar code. You can select one of the 
formats with the following filter. 
01 and 11 0..9, space 

02 and 12 A..Z, space 

03 and 13 A..Z, 0..9, space 

04 and 14 A..Z, 0..9, space,.-/ 

05 and 15 7-bit ASCII lower part (from 0 to 127)
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06 and 16 all 

07 and 17 7-bit ASCII 

 
The formats from 1 to 7 allow the data length to 500 characters, while formats from 11 to 17 
allow to 2000 characters. 
Border Size 
Factors from 1 to 15 set the dimension of the border in the shape of the character “L”. 
Data Matrix can encode: 

• Full 128 ASCII character set 
• All ISO characters 
• All EBCDIC characters 

EAN.UCC 128 Bar Code 
This bar code is combined from one or more input values and standard AID - Application 
Identifiers. Each AID must be followed by the standard values. These values can be fixed or 
variable. 
When the EAN.UCC 128 bar code is selected, the Bar code data field in the Bar code 
Wizard dialog box is disabled. To define the contents of the bar code, click the Next button.  
From the list of available Application Identifiers select the first identifier. It will be written in 
bracket bellow the bar code. 
When the Application Identifier includes also check digits, you have to define whether it will 
be calculated or entered together with data. 
Next, define how you will set the values for the selected identifier. You may enter fixed value 
or define variable value.  
Fixed values 
When values are fixed, the Wizard dialog box will inform you what is expected to be entered 
– digits the maximum places... 
The defined AID is presented on the list of selected Application Identifiers. Click the Add 
button to add a new AID or on the Delete to delete existing one. 
Should you need to change the AID and the data, select the AID and click the Edit button. 
You can sort the listing of AID by using the Up and Down buttons.  
All the settings can be previewed on the Preview field.  
The separator among Application Identifier can be defined by entering the required separator 
for the left and for the right side of the Application Identifier. The default separator is bracket. 
Variable values 
EAN.UCC 128 bar code supports keyboard variables – the variable data will be entered from 
the keyboard. 
You can define the Prompt – the message for the operator, who will enter the data. 
The data can be numeric only or the operator is allowed to enter all characters. 
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The value can be fixed or incremented/decremented on every label or certain number of labels 
with the desired step. 
The variable data will be written in the Preview field as a series of "A" character. 
When you are satisfied with the settings, click the Finish to put the EAN.UCC 128 bar code to 
the label.  

MaxiCode 2D Code 
General tab 
Y expansion factor 
This option defines the height of the bar code symbol. 
Details tab 
When the option Structured is not selected, the content of the bar code is optional.  
For Structured bar code you may encode only standard contents. 

PDF 417 2D Code 
General tab 
Y expansion factor 
This option defines the height of the bar code symbol. 
Security tab 
Accordingly to the standard, you can select among 9 levels of security. Higher security level 
allows more reliable reading regardless errors, but the bar code symbol is bigger. 
Truncated bar codes can be used where label damage is unlikely and there is no demand for 
very high level of security. The truncated symbol is smaller. 
Aspect Ratio 
It is the ratio between number of columns and number of rows.  
Contents 
PDF 417 code can encode: 

• Full 128 ASCII character set 
• All 128 Extended ASCII characters 
• 8-bit binary data 

 

Check Digit Tab 

This tab is used to specify if you want to use the check digit in the bar code or not. This 
option can only be modified for the bar codes that allow you to enable and disable the check 
digit. 
Some bar code standards include the check-digit by the definition and it cannot be omitted. 
An example of such bar codes are EAN and UPC bar codes, where check digit cannot be 
disabled at all. But some codes allow you to freely enable/disable check-digit. 

Note: 
It is always recommended to include the check digit character in the bar code. It will 
increase the scanning reliability. 
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Edit bar code dialog box – Check digit tab 

You can choose whether you want to input the check digit value, or let the program calculate 
it for you: 
Auto-generate check digit: Check digit is calculated by the software. You must only enter 
the bar code data. For example: when using EAN-13 bar code input the first 12 digits, check 
digit on 13th place will be calculated and added automatically. 
Verify the provided check digit: Use this command when you want to enter the value for the 
check-digit. At print time the entered check digit it will be verified for validity. 
Enable custom check digit algorithm: You can set some other algorithm you want to use for 
calculating the check digit. Click on the button Select to choose the algorithm. 

Details Tab 

On this tab you can define advanced settings for the bar code. 

Note: 
Not all of these options are available for all bar codes and printers. 

Include quiet zones: By checking this field you set, that the bar code will have some white 
space in the front and in the end for increased readability. 
Descender bars: Some bars of a bar code will be longer than others. This is typically used 
with EAN and UPC bar codes that have longer bars in the begging, in the middle and in the 
end of the bar code. 
Mirror horizontally/mirror vertically: The bar code can be mirrored vertically and 
horizontally. bar code will usually have to be printed as graphics for this option to be 
accessible. 
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Intercharacter gap: Some bar codes allow you to change the gap between characters in the 
bar code (e. g. Code-39). 
Include EAN white space: Before and after the bar code a special character is inserted, < or 
>. It indicates the width of the bar code. If you put any other object in the extent of the bar 
code, it will reduce the readability of the bar code. This option is only valid for EAN bar 
codes. 

 
Edit bar code – Details tab 

Edit Bar Code Dialog Box 

This dialog box is displayed when you click the Define button on the bar code dialog box. On 
this dialog box you specify the type of bar code you want to use on the label and all additional 
advanced setting: how the bar code should be generated, if check digit should be 
automatically calculated or not, and various other options. The preview of a resulting bar code 
is displayed on the right side of the dialog box, if Enable preview check box is checked. 
When you are satisfied with bar code's properties, confirm the changes you made by clicking 
the OK button or reject them and keep previous settings by clicking Cancel button. 
Edit bar code dialog box has several pages (tabs). 

General Tab 

On this tab you can select the bar code type you want to use and the properties of the bar 
code. 
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Edit bar code dialog box – General tab 

Type of bar code: The required bar code symbology is selected from the tree list of available 
bar codes. 
Symbol height: The height dimension of a bar code can be specified either by entering a 
value here or by resizing the bar code symbol directly on the label. 
X-Expansion factor: The expansion factor defines the width of the bar code symbol. 
Ratio: This is the ratio between narrowest and widest bar in the bar code. It is locked for 
majority of bar codes, but it can be changed for some. 
Base object width: Shows the width of a narrowest bar in the bar code. 
Print bar code as graphics: Select if bar code should be converted to picture and sent to the 
printer as image or should the printer print bar code as internal element. Printing internal bar 
codes will speed up label printing, because less data must be transferred to the printer. 

Note: 
If the printer does not support the selected bar code internally, the option Print bar 
code as graphics will not be available. All office printers will print bar codes as 
pictures. 

Human Readable Tab 

On this tab you can set the options regarding position and format of the bar code 
interpretation. 
No interpretation: Bar code object does not have any human interpretation. 
Below bar code: All data encoded in the bar code is placed beneath the bar code symbol as 
human readable characters. 
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Above bar code: All data encoded in the bar code is placed above the bar code symbol as 
human readable characters. 
Font: Using the Font button, you can choose the suitable font for auto-translation text. The 
option Auto font scaling will adjust the font of the auto translation text to the size of the bar 
code. 

Note: 
You can only format the font for human interpretation, if the bar code is printed as 
graphics. When printing bar code as internal printer object, the printer will print the 
interpretation using resident built-in fonts. 

Contents mask sets the custom format of the human interpretation. 

 
Edit bar code dialog box – Human readable tab 

Supported Bar Code Types 

Bar code 
Group 

Bar code Types 

EAN and 
UPC 

EAN-8, EAN-8 + 2-digit supplement, EAN-8 
+ 5-digit supplement, EAN-13, EAN-13 + 2-
digit supplement, EAN-13 + 5-digit 
supplement, EAN-14, DUN-14, UPC Case 
Code, UPC-A, UPC-A + 2-digit supplement, 
UPC-A + 5-digit supplement, UPC-E, UPC-E 
+ 2-digit supplement, UPC-E + 5-digit 
supplement, UPC-E(1), EAN.UCC 128, SSCC, 
Bookland, Addon 2, Addon 5 

Linear Interleaved 2 of 5, ITF 14, ITF 16, Code 39, 
Code 39 Tri Optic, Code 39 Full ASCII, Code 



Label Gallery User Guide 

84 

32, Code 93, CODE 128 (A, B and C subsets), 
MSI, Codabar, Postnet-32, Postnet-37, Postnet-
52, Postnest-62, Kix, Pharmacode, Plessy, 
Anker 

RSS Linear RSS symbologies 
RSS14, RSS14 Truncated, RSS14 
Stacked, RSS14 Stacked Omnidirectional, RSS 
Limited, RSS Expanded 
Composite RSS symbologies 
RSS14, RSS14 Truncated, RSS14 Stacked, 
RSS14 Stacked Omnidirectional, RSS Limited, 
RSS Expanded, UPC-A, UPC-E, EAN-8, 
EAN-13, EAN.UCC 128 & CC-A/B, 
EAN.UCC 128 & CC-C 

Two-
dimensional 

2D-Pharmacode, PDF-417, DataMatrix, 
MaxiCode, Aztec, QR, MicroQR, Codablock 
F, MicroPDF, InfoGlyph 

 

Using Bar Code Wizard 

Bar Code Wizard 

 
First page of bar code Wizard 

Bar Code Wizard guides you to define all parameters for the text object. 
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Fixed bar code data: Select this option if you would like to have a fixed non-changeable 
content of the object. If you select this option, you can enter the text directly in this dialog 
box. 
Variable text: Select this option, if you would like to have variable content of the object. 
Defining the content is defined in the next step. 

Note: 
When entering values for RSS composite bar codes, you need to provide the value for 
the linear and composite (2D) parts at the same time. 

Use the following syntax for entering values for RSS composite bar codes. The pipe character 
(|) is used to distinguish between the components. 
The syntax: <linear part>|<composite part> 
The example: 12345|description 

Bar Code Wizard - Choosing Variable Bar Code 

Select the type of the variable field you want to use. 
Variable name: Type in the name of the variable that will be linked to the bar code object 
and will provide the value for it. 
The next page of the wizard depends on your selection here. 

Bar Code Wizard - Counter 

On this page of the wizard, you define the counter variable. 
Starting Value: Set the starting value for the counter. The counter will increment or 
decrement from the starting value. 

Note: 
You can enter only digits for the starting value. 
  

Prompt for value before print: Tick this option to enable entering the starting value of the 
counter when you start printing labels. Enter the text that will be shown to the user before 
printing. 
The message will be shown on the screen each time when the label is to be printed.  
Set maximum number of digits: Define the maximum length of digits the counter can 
occupy. 
Increment or decrement: You can define that the variable value will increase from label to 
label, or decrease. 
Preview: The field shows the preview of the counter, based on your selection. 

Text Wizard - Counter Continuation 

Step: Define the step for your counter. The counter will increase by this number on every 
label. 
Change value every <n> labels: Define the number of labels, when the counter will change 
the value. 
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Rollover when reached: Enter the value, when reached, will cause the counter to reset the 
value to the starting value. 

Bar Code Wizard - Database 

Variable field linked to the database gets the value from the specified database field. 
Define: Click on this button to open the database wizard that will help you define the link to 
the database. 
Field: Choose one of the available database fields as a source for the variable field. 
Length: Define the maximum length of the string in variable. If field in database contains 
more characters, they will not be printed. This option is useful if the field length in your 
database is not fixed (for example tab delimited ASCII file), or if you don't want to reserve 
space for all the characters in database's field. 

Bar Code Wizard - Date Field 

Define the properties of the date field. The variable field will get the value from a computer 
clock. 
Format: Select the format for your date from the list. You can also enter the custom format. 
Date offset: You can add a certain numbers of days, months or years to a current date and 
print that date instead of the current one. 
Preview: The printer will print the date as shown on the Preview field. This way you can see 
how the selected date format will look on the label. 

Bar Code Wizard - Keyboard Input 

Use this variable type when you want the operator to enter a value of the variable from the 
keyboard before printing the specified numbers of labels. 
Prompt text for this variable field: Fill in the message that will be shown to the user when 
he will enter tne values for the variable field. 
Format: Select the format of data you allow to be entered for the variable field. 
Set maximum number of characters: Define the maximum length of characters that can be 
entered for the variable field. 

Bar Code Wizard - Prefix and Suffix 

The variable element can have a prefix and suffix values. The prefix text is placed in front of 
the variable's value. The suffix text is place at the end of the variable's value. 

Note: 
If you leave the edit fields empty, the prefix/suffix will not be used. 

Prefix and suffix can be used in situations where they are required only if the variable has set 
some value. If the variable is empty, the prefix/suffix will not be printed as well. 
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Bar Code Wizard - Time Field 

Define the properties of the time field. The variable field will get the value from a computer 
clock. 
Format: Select the format for the time from the list. You can also enter the custom format. 
Preview: The printer will print the time as shown on the Preview field. This way you can see 
how the selected date format will look on the label. 

Using EAN.UCC 128 Wizard 

Calculating Check Digit 

Select how the check digit will be calculated. 
1. You can enter the check digit with the data and the software will validate it. 
2. The software can calculate the check digit. 

Defining New Variable 

Define the properties of the variable that will provide value for the application identifier. 
Prompt: Enter the text that will be displayed to the user at print time. 
Format: Define the format of the variable. 
Counter: If the variable will be a counter, define its properties. 

Step 1: Choosing the application identifier 
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EAN.UCC 128 Wizard: Choosing application identifier 

The dialog in the first step of Wizard allows you to select the EAN.UCC 128 bar code data 
structure. Each bar code is composed out of one or more Application Identifiers and the 
corresponding data. 
Choose one of the Application Identifiers in this list. You can add, edit or delete Application 
Identifiers from the bar code later in the process. 

 
EAN.UCC 128 Wizard: How check digit should be applied 

If you have selected the Application Identifier which data includes a check digit (for example, 
AI (01) - GTIN, Global Trade Item Number), then first you will have to select how the check 
digit will be applied. The possible options are: 

 Automatic calculation: Check digit will be calculated by the application. 
 Check digit to be entered with data: Manually enter the data and check digit. The 

application will verify, if the entered check digit is valid. 
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Step 2: Application Identifier Input Type 

 
EAN.UCC 128 Wizard: Where the data for AI is obtained from 

When the Application Identifier is selected, you will have to define where is the data for its 
value obtained from. There are three possible options: 

• Fixed: The application identifier will have the fixed value on every label. 
• New variable: The application identifier will be linked to the variable and have 

variable value on each label. You will define a new variable. 
• Use existing variable: The application identifier will be linked to the variable and 

have variable value on each label. Select the existing variable from the list. 

Step 3: Entering the value for the Application Identifier 

Entering fixed value for the application identifier 
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Entering fixed value for the application identifier 

If you have selected fixed value in the previous dialog box, you should enter value for the 
Application Identifier here. The Wizard will let you know about the required data format fort 
this AI and how long the AI value should be. For some AI's the field length is fixed to certain 
number of digits, for others only the maximum number of possible digits is stated. You will 
also be reminded of the AI's proper field format (numeric, alphanumeric) if you enter 
incorrect data. 
Entering variable value for the application identifier 
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Creating new variable for the application identifier 

If you have selected new variable value in previous dialog box, a new variable field will be 
created. You will have to provide some information about variable being used. 
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Step 4: List of selected application identifiers 

 
Listing the selected application identifiers 

This is the last step of the EAN.UCC 128 Wizard. Here you can add, edit or delete 
Application Identifiers and define separator among them. 
Application Identifiers selected: In this field all selected application identifiers for the bar 
code are listed in the order of creation. You can change the order with the arrow buttons. 
Add, Edit or Delete buttons: Use these buttons to add additional application identifiers and 
edit or delete existing ones. 
Input Application identifier delimiter: Define left and right separator among different 
application identifiers. The default setting is to use round parenthesis. 
Preview: A sample bar code content based on your application identifier selection is shown 
here. 
Click the Finish button to exit the wizard. 

Using EAN.UCC 128 Wizard 

This wizard allows you to define the data structure for EAN.UCC 128 bar code. This kind of 
bar code has different areas of application that include trade items, logistic units, assets and 
locations. 
The EAN.UCC 128 bar code is an extremely flexible symbology. It allows representation of 
data of variable length, and makes it possible to encode several pieces of information in one 
bar code symbol. This is called concatenation. An Application Identifier is the field of two 
or more characters at the beginning of an data value. Application identifiers are prefixes that 
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uniquely identify the meaning and the format of the data field following. The data fields are 
either of fixed or variable length, depending on the AI. 

Using Text Wizard 

Text Wizard 

 
First screen of Text Wizard 

Text Wizard guides you to define all parameters for the text object. 
Fixed text: Select this option if you would like to have a fixed non-changeable content of the 
object. If you select this option, you can enter the text directly in this dialog box. 
Variable text: Select this option, if you would like to have variable content of the object. 
Defining the content is defined in the next step. 
Font: Currently selected font type is shown in this field. 

• Inverse: Enable this option to use the text in inverse. 
Note: 
The option is not available for all printers. 

• Select button: You can select different font type for this text object among available 
fonts in the system. 
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Text Wizard - Choosing Variable Text 

 
Text Wizard - Choosing variable text 

Select the type of the variable field you want to use. 
Variable name: Type in the name of the variable that will be linked to the bar code object 
and will provide the value for it. 
The next page of the wizard depends on your selection here. 

Text Wizard - Counter 

On this page of the wizard, you define the counter variable. 
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Dialog box for Text Wizard when Counter option is chosen 

Starting Value: Set the starting value for the counter. The counter will increment or 
decrement from the starting value. 

Note: 
You can enter only digits for the starting value. 
  

Prompt for value before print: Tick this option to enable entering the starting value of the 
counter when you start printing labels. Enter the text that will be shown to the user before 
printing. 
The message will be shown on the screen each time when the label is to be printed.  
Set maximum number of digits: Define the maximum length of digits the counter can 
occupy. 
Increment or decrement: You can define that the variable value will increase from label to 
label, or decrease. 
Preview: The field shows the preview of the counter, based on your selection. 

Text Wizard - Counter Continuation 

Step: Define the step for your counter. The counter will increase by this number on every 
label. 
Change value every <n> labels: Define the number of labels, when the counter will change 
the value. 
Rollover when reached: Enter the value, when reached, will cause the counter to reset the 
value to the starting value. 
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Text Wizard - Database 

Variable field linked to the database gets the value from the specified database field. 

 
Dialog box for Text Wizard when Database option is chosen 

Define: Click on this button to open the database wizard that will help you define the link to 
the database. 
Field: Choose one of the available database fields as a source for the variable field. 
Length: Define the maximum length of the string in variable. If field in database contains 
more characters, they will not be printed. This option is useful if the field length in your 
database is not fixed (for example tab delimited ASCII file), or if you don't want to reserve 
space for all the characters in database's field. 

Text Wizard - Date Field 

Define the properties of the date field. The variable field will get the value from a computer 
clock. 
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Dialog box for Text Wizard when Date field option is chosen 

Format: Select the format for your date from the list. You can also enter the custom format. 
Date offset: You can add a certain numbers of days, months or years to a current date and 
print that date instead of the current one. 
Preview: The printer will print the date as shown on the Preview field. This way you can see 
how the selected date format will look on the label. 

Text Wizard - Keyboard Input 

Use this variable type when you want the operator to enter a value of the variable from the 
keyboard before printing the specified numbers of labels. 
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Dialog box for Text Wizard when Keyboard input option is chosen 

Prompt text for this variable field: Fill in the message that will be shown to the user when 
he will enter tne values for the variable field. 
Format: Select the format of data you allow to be entered for the variable field. 
Set maximum number of characters: Define the maximum length of characters that can be 
entered for the variable field. 

Text Wizard - Prefix and Suffix 

The variable element can have a prefix and suffix values. The prefix text is placed in front of 
the variable's value. The suffix text is place at the end of the variable's value. 
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Setting Prefix and Suffix string for the variable text element 

Note: 
If you leave the edit fields empty, the prefix/suffix will not be used. 

Prefix and suffix can be used in situations where they are required only if the variable has set 
some value. If the variable is empty, the prefix/suffix will not be printed as well. 

Text Wizard - Time Field 

Define the properties of the time field. The variable field will get the value from a computer 
clock. 
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Dialog box for Text Wizard when Time field option is chosen 

Format: Select the format for the time from the list. You can also enter the custom format. 
Preview: The printer will print the time as shown on the Preview field. This way you can see 
how the selected time format will look on the label. 

Aligning Objects 

First you have to select objects that you want to align. 

Note: 
All objects are aligned relatively to the first selected object. 

Then click appropriate buttons in the Design toolbar to align selected objects to each other. If 
Align toolbar is not visible (by default it is located on the very right side of the window), 
enable the Design toolbar in Toolbar option in View menu. 
You can align objects to: 

Left 

Right 

Horizontal center 

Top 

Bottom 

Vertical center 
You can also distribute object evenly, so that spacing between them is equal: 
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Horizontally 

Vertically 
Note: 
If you hold the <CTRL> key while clicking the buttons, objects are aligned relative to 
label and not to the first selected object. 

The shortcut <Ctrl> + A opens the Align dialog box with same functionality as the Design 
toolbar. 

Clipart Galleries 

The distribution of labeling software includes a library of frequently used clipart images that 
you can use on your labels. Images are stored in .GIF and .WMF file formats. They are black 
& white images. 
Clipart Galleries incorporate useful images from retail, logistics, chemical, automotive and 
other industries. Subset of these galleries is included within the two Font files, but for the 
whole collection of available symbols you should browse the galleries. 

Editing Objects 

To edit the properties of the object, do the following: 
1. Double-click the object on the label. 

The dialog box with object properties will open. 

Note: 
You can also press the <Enter> key, while the object is selected. 

2. Make modifications to the object properties. 
3. Click on the Finish button. 

Font Files 

Along with the labeling application you have also got two fonts with graphical symbols. You 
can use them on your labels. They contain frequently used care symbols (used in textile 
industry), symbols for handling dangerous materials (used in chemical industry) and many 
other useful industry symbols. The fonts are not automatically installed on your system, but 
should you require them, they are stored on your CD-ROM. They are accessible from the 
folder X:\AddOns\Fonts, where X represents the letter of CD-ROM drive in your system. 
The fonts are in standard TrueType format and can be installed using Fonts utility in Control 
Panel. They are accompanied with two document files that include all symbols from the fonts 
in a easily scanned formatted table. 
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Character map of Care Symbols Font - CARESYM.TTF 

 
Character map of EP Symbols Font - EPSYM.TTF 

Moving Objects 

To move the object on the label, do the following: 
1. Select the object. 
2. Click on the object with the left mouse button. 
3. Hold the mouse key pressed. 
4. Move the position of the cursor on the screen. 

The object will move with the cursor. 

Resizing Objects 

To resize the object on the label, do the following: 
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1. Select the object. 
The selected object is framed with a rectangle. 

2. Click on one of the small rectangles in the corners of the rectangle. 
3. Hold the mouse key pressed. 
4. Move the position of the cursor on the screen. 

The object will resize with the cursor. 

Rotating Objects 

To rotate the object, do the following: 
1. Select the object. 

2. Click on the  icon in the design toolbar. 
The object will be rotated for 90° clockwise. 

Note: 
If the design toolbar is not visible, select the command Toolbars in the View menu, then 
click on the Design. 

Selecting Objects 

To select two or more objects, you should press the <Shift> key, and hold down, while 
clicking the object with a mouse. 
The objects can be selected, cut, copied, pasted and edited with the right mouse button. If you 
click the right mouse button on the object, the menu shows all the available commands. Note 
that these commands are equivalent to correspondent menu commands. 
You can also change the anchoring point of a selected object by holding <CTRL> while 
clicking the placeholders (corners of the bounding box) of the object. 
 

Supported Graphics Formats 

The following graphical formats are supported: 
File 
extension 

Graphics type 

BMP, DIB, 
RLE 

Windows Bitmap 

GIF CompuServer Bitmap 

JPG, 
JPEGM JPE 

JPEG Bitmap 

TIFF, TIF, 
FAX, G3N, 
G3F 

TIFF Bitmap 

PNG Portable Network 
Graphics 
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WMF Windows Metafile 

EMF Enhanced Windows 
Metafile 

ICO Windows Icon 

CUR Windows Cursor 

TGA, 
TARGA, 
VDA, ICB, 
VST, PIX 

Targa Bitmap 

PXM, PPM, 
PGM, PBM 

Portable Pixmap, 
GreyMap, BitMap 

JP2 JPEG2000 

J2K, JPC JPEG2000 Code Stream 

PCX Paintbrush 

 

Working with Pictures 

Images can be various sizes. If the original size of the graphics is not valid for your label, you 
can freely resize the image by dragging the handles surrounding it. The image can be resized 
proportionally or stretched in both directions. 
The graphics objects can also be placed on the label from the clipboard or imported from 
another applications (i.e. Corel Draw, scanning programs...), using either the Insert Object or 
Paste command from the Edit menu. In this case, the graphics is embedded in the label file. 
What this means is that it is entirely stored in the label file and is not stored separately on the 
hard disk. However, the graphics imported this way can be saved to the file at any time. 
When you define graphics as an variable object (some variable defines the name of the 
picture), Label Gallery does not know the size of the picture in advance, because this 
information is provided only at print or preview time. That is why, there will be a picture-box 
on the screen, containing a large question mark. 
 

Working with Text Objects 

There are two modes of operation, which can be set by setting program preferences. The first 
(default) is "On screen edit". This means, you can enter text directly on the label, similar to a 
word processor program. When you have typed the contents, you can cancel typing by 
pressing <Esc> key, or confirm it by pressing <Ctrl+Enter>. The text object is created. 
The second mode immediately opens the dialog box for the text, where you can enter the 
contents and set all other properties of the text. This dialog box can also be opened any time 
by double clicking the text object or by right clicking the object and selecting Edit from 
menu. 
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Working with Variable Data 

Contents Providers 

Contents Providers 

Contents Provider is an expression for any method that can be used as an source of data for 
elements on the label. It is applicable to all label elements that can have some sort of data 
associated with them (Text, Text box, Rich text box, Bar code and Picture). 
The contents provider for elements can be one of the following: 

Fixed When you select Fixed, you can enter a 
desired value in the edit box. This value will 
remain the same on each label. To edit the 
text, all standard Windows editing features 
(cut, copy, and paste) can be used. If you need 
to enter some special character, that is not 
accessible via keyboard, click the button with 
the arrow to the right of the dialog box. You 
can also right-click anywhere in the edit box 
and select "Insert special character" from the 
menu. 

Variable When the Variable option is selected, you can 
connect any variable field to the element, just 
select the appropriate variable name from the 
list. This approach will allow you to change 
the element's value on the labels. 
Element is connected to some variable. The 
variable is defined on the label. Its type can be 
Keyboard Input, Counter, Date/Time field etc. 
When variable's value changes, the change 
will be reflected in the appearance of the 
selected element. 
If no variable is defined on the label, you 
should first create one. Click Wizard button to 
start Variable Wizard, that will guide you 
through the steps of creating the variable. 
Variable field will be created very easily, but 
cannot be used for setting of all the options. 
For advanced variable setup click New button. 
Edit button will let you change properties of 
selected existing variable. You will find more 
information about variables in the topic 
Variables. 

Functions When this type of contents provider is 
selected, you can select the proper function 
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from the list of defined functions and then also 
the output function-generate variable. This 
variable will be the source of data for the 
element. 
Click New to create new function. Click Edit 
to change function's properties. 

Database When this type of contents provider is 
selected, you can select the proper database 
from the list of defined database connections. 
Then select the proper field from this database. 
This field will be the source of data for the 
element. 
Click New to create connection to new 
database (click Wizard to use the wizard for 
the connection). Click Edit to change 
function's properties. 

Expression Expression is an simplified version of Visual 
Basic Script. Expression can be used in 
situations when you want to manipulate 
existing variables, extract some sub-string or 
perform a quick calculation and you do not 
want to write a dedicated Visual Basic script. 
For this purpose Expression will do just fine. 
You can enter one-line expression in the edit 
field that will be validated at print-time. Of 
course all Visual Basic scripting commands 
can be used in here. 

Visual 
Basic 
Script 

An entire Microsoft Visual Basic Script 
functionality can be included on the element. 
Each element can have assigned its own 
programming script for advanced 
functionality. 
Visual Basic Script option will allow you to 
use a complete implementation of Visual Basic 
programming scripting, provided my 
Microsoft Corporation. This makes is possible 
to perform advanced data manipulations, 
comparisons and calculations directly on the 
label. If you are not familiar with Visual Basic 
scripting, a comprehensive help system is 
accompanying the labeling application. To 
access is, click the VB Script Help file. Once 
your script is written, it will be check for the 
consistency and syntax errors and you will be 
notified of the exact positions of any possible 
error for easier problem solving. There is one 
thing you have to pay special attention to: your 
script has to define an output variable Result. 
It will be used for actual value setting. For 
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more complex scripts click the Build script 
button to edit your code in Expression Builder. 

Link to 
File 

The value for the label element is acquired 
from the specified text file in this case. The 
contents of the file is used for the element. 
You can link the element to some fixed 
filename on the disk. Or you can use variable 
filenames. To achieve that connect the element 
to the variable containing the path and 
filename of the file. 

Lookup 
Table 

Lookup Table is a facility for the user to 
simplify working with data tables. Although 
the software can interact to any database, 
sometimes there is a need only for one quick 
simple table that stores your data. Lookup 
Table provides a shortcut to database usage. 
Lookup Table is used when you want to use a 
data from a simple database on your label. 
You can use some external databases as data 
source for all variable fields. But Lookup 
Table greatly simplifies this task. It is in fact a 
table stored within the label file. Built-in 
database editor can be used to manage the data 
records. Every Lookup table can have a Key 
(Primary) and Secondary Key that are used 
for actual data query. Using these keys you 
can make a query into the table and extract 
only fields that comply to the condition. Both 
keys can be either fixed or get a value from 
some variable. When the record from the table 
is found based on information from one or 
both keys, the value of the database field 
selected in Output fields is returned as the 
element's contents. The element on the label 
now has its value from the database. The 
button Configure tables will let you manage 
your Lookup Tables. 

FACT FACT is used when you want to encode the 
data using this standard for Data Identifiers 
(DI). It is much like EAN.UCC 128 standard 
and its Application Identifiers (AI). 

HIBC There is the ability to encode data in the 
element using HIBC standard. 

Rich Text 
Editor 

This contents provider is available only for 
RTF element. It provides you with the RTF 
editor, where you can define the fixed or 
variable contents for the element. 

Structured 
RSS bar 

This contents provider is available only when 
using RSS type of bar code. It provides you 
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code with the functionality to provide linear and 
composite (if applicable) data to the bar code. 

RFID 
Unique 
Tag ID 

This contents provider is available for text and 
bar code objects. It is available when you have 
RFID-aware printer driver connected to the 
label and it can acquire the Unique Tag ID 
from the RFID tag embedded in the label. 
The Unique Tag ID is the number that is 
programmed in the RFID tag during the 
manufacturing process. The number is unique 
and cannot be changed. 
The printer will read the Unique Tag ID, 
remember the value and use it with the internal 
text or bar code objects on the label. Because 
this data is never returned to labeling software, 
but is handled internally in the printer, the data 
you enter for this contents provider is used on 
the screen for preview purposes only. 
RF Tag selection in this contents provider is 
available only when you did not enable the 
RFID functionality in the RF Tag dialog box. 
Otherwise the RF Tag selection is dimmed and 
properties can only be changed with the 
Advanced button. 
Different printers have support for different 
RF Tags and have different methods to read 
the value from the tag (byte by byte or data 
block by block). 

 

Creating Custom Check Digit 

Creating Custom Check Digit 

You can add new or edit and delete existing algorithms by clicking appropriate buttons. 
Algorithm's parameters are defined in Edit algorithm dialog box, which has following 
options: 



Designing Labels 

109 

 
Editing check digit algorithm 

To understand all parameters, you must know, how check digit is calculated. First of all, we 
must have a numeric value and on top of that the check digit will be calculated. If weights are 
required, we will need them as well. Let's look at EAN13 check digit calculation: 
Value: 123456789012 
Weights: 1, 3 
When starting calculating, each digit has its weight. When only two weights are specified, the 
third digit gets the first weight, the forth the second, and so on. If only one weight is specified, 
all digits have the same weight. According to Sum determination, we can use weights (sum of 
the products) or not (sum of the digits). EAN13 algorithm uses products, so we define Sum of 
the products. 
The sum is: 1×1 + 2×3 + 3×1 + 4×3 + 5×1 + ..... + 2×3 
When the sum is calculated, we take modulus parameter and divide the sum with that number 
and remember the remainder of division. This can already be the result.  
If Result complemented is specified, we subtract the result from modulus-1 and so we get the 
new value. When this value is less than 10, we already got check digit. If it is greater value 
(two digits), we take the whole value or just the least significant digit (One digit only) as the 
result of check digit algorithm. 

Special Characters 

Entering characters with <#hex_code> syntax 

Another method of entering special characters is using the syntax <#hex_code>. The 
hex_code stands for a two-character mark in hexadecimal numerical system. The appropriate 
values go from 0 (decimal 0) to FF (decimal 255). 
For example, <#BC> (decimal 188) would be the same as <FNC1>, as they both would 
encode the character with ASCII code 0188. 
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Entering characters with Alt+<ASCII_code> 

This method is valid only for characters that are above ASCII code 32. A typical example 
would be FNC codes that are used to encode EAN.UCC 128 bar code data. The labeling 
software will encode this type of bar code according to standards and normally you would not 
have to change anything about it. However, sometimes it is necessary to manually add such 
character to label data. 
To include Function Codes just type in the appropriate character for Function Code. ASCII 
codes of Function Codes are as follows: 
FNC1 0188 

FNC2 0189 

FNC3 0190 

FNC4 0191 

 
To type in character for FNC1, press and hold down left Alt key, then type in digits 0188 on 
the numeric keyboard. Note the leading zero, it is mandatory. Release the Alt key and FNC1 
character should appear. 
These characters can be typed in directly using the keyboard. 
 

Pre-defined Character Shortcuts 

The labeling application has several control characters pre-defined and they can be selected 
from a drop-down menu in any dialog box, where a text input is enabled. Just look at the right 
side of the edit field and find a button with arrow. Click it for a list of all available shortcuts 
to pre-defined characters. The same list can be accessed with right-click on the edit field, 
where you select Insert special character. For example: FNC1 character can simply be 
encoded as <FNC1>. 
If special characters you want to use on the label is not available in this list of shortcuts, 
consult additional input methods. 
ASCII 
code 

Abbreviation 
used in the 
application 

Description of 
the character 

1 SOH Start of Heading 

2 STX Start of Text 

3 ETX End of Text 

4 EOT End of 
Transmission 

23 ETB End Transmission 
Block 

25 EM End of Medium 
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5 ENQ Enquiry 

6 ACK Acknowledgement

7 BEL Bell 

8 BS Back Space 

9 HT Horizontal Tab 

11 VT Vertical Tab 

13 CR Carriage Return 

10 LF Line Feed 

12 FF Form Feed 

14 SO Shift Out 

15 SI Shift In 

16 DLE Data Link Escape 

17 DC1 XON - Device 
Control 1 

18 DC2 Device Control 2 

19 DC3 XOFF - Device 
Control 3 

20 DC4 Device Control 4 

28 FS File Separator 

29 GS Group Separator 

30 RS Record Separator 

31 US Unit Separator 

21 NAK Negative 
Acknowledgement

22 SYN Synchronous Idle 

24 CAN Cancel 

26 SUB Substitute 

27 ESC Escape 

188 FNC Function Code 1 

189 FNC Function Code 2 
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190 FNC Function Code 3 

191 FNC Function Code 4 

 

Using Special Characters 

Special characters are the kind of characters you usually cannot find directly on your 
keyboard. In spite of that, some of them can be typed in using combinations of Alternate and 
Control keys. 
The problem usually does not appear with your language-specific characters (ä, í, ń, ş, č, A 
etc), you can enter them directly on the keyboard or using Alt+<key_code> combination. 
alternatively Windows utility Character Map can be used to find appropriate character and 
paste it to the label. 
You might have problems using other kind of special characters. Sometimes there is a need to 
include a character with ASCII code below 32. These are so-called control characters. They 
cannot be normally entered to labeling or any other application. There is an alternative 
method of entering such characters, explained later in this topic. 
There are several methods how special characters can be typed in to the labeling software. 

Working with Databases 

Linking a Label to Advanced Databases 

Link to a Database Manually 
The Database Wizard does not support your database if it is not listed in the direct database 
access  or does not have an ODBC driver. In just a case you have to link your database to 
your label manually by doing the following: 

1. Click on the button in the Standard Toolbar. The Database Wizard will 
open. 

2. Select the option Other databases (ODBC) and click on the Browse button. 
Use this option, if you use server-based databases like SQL server, Oracle, Informix or 
some database not directly supported by the option Direct database access. 

3. Select the available ODBC definition in the list. 
4. Click on the Define button, if the connection to your database is not already defined. 
5. The dialog box Database opens. 

Here you can define the connection to your database. 
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Manual definition of the database connection 

6. Click on the OK button. 
7. Continue from the step 4 in the chapter Link to a Database Using Database Wizard. 

Link to a Database Using Database Wizard 

1. Click on the button  in the Standard Toolbar. The Database Wizard will 
open. 

2. Select the option Direct database access and click on the Browse button. 
Use the option Direct database access, if you use file-based databases like Microsoft 
Access, Paradox, dBase, Excel or .TXT files. 

 
Selecting the type of database connection 

3. Point to the Paradox database C:\Program 
Files\Sato\Gallery2\Samples\Database\IDENTITY.MDB. 

4. Click on the Next button. The next step Fields Selection of the Database Wizard will 
open. 
The dialog box will show all fields defined in the database table. 
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All fields defined in the database table are displayed 

5. Leave the default settings and click on the Next button. A next step Records Printing 
of the Database Wizard will open. 

6. Leave everything on a default settings in this dialog box. 
What this means is that all records from the database will be printed and each record is 
used on one label. 

 
Select how the records from the database will be used on the label 

Click on the Next button. A next step Fields Usage of the Database Wizard will open. 
7. Leave everything on the default settings. 

The wizard will automatically connect all database fields to the text objects on the 
label. 

8. Click on the Finish button. 
The Database Wizard will connect to the database, obtain the fields and make them 
available on the label as variables. The variables will be linked to the text objects. 

Overview 
You can use the Label Gallery software to retrieve data from any database on your computer 
or network. If you have the appropriate database drivers, you can connect to the database and 
use the records on the label. 

Note: 
Label Gallery Easy does not have all database options available. You can only use data 
from text databases and Excel spreadsheets in Label Gallery Easy. 
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With Label Gallery software you can connect to any database type as long as you have the 
appropriate database drivers installed on your computer. Label Gallery supports different 
database drivers like ODBC, OLE DB and BDE. Your computer comes pre-installed with 
database drivers for frequently used database types, but you can always install additional 
drivers. 
You have total control over which records in the database table will be printed. By default all 
records are printed, but you also have the option to select the records for printing. Before the 
labels are processed you can select the records in the table that you want to print. You can 
also specify the print quantity for each record. 
Advanced record selection techniques are also available in Label Gallery software. You can 
create database filters and obtain only the records that match the conditions. The same 
functionality allows you to join two or more database tables together and obtain values for the 
same product from multiple databases. 
Manual modification of the SQL sentence is available for advanced users. 

Print All Database Records 
By default the Database Wizards sets up the database connection to print all records in the 
database. The Database Wizard step Records Printing is where you can define which records 
are printed. 
To print all records in the database table follow the steps in the chapter Link to a Database 
Using Database Wizard. 

Note: 
To print all records in the database it is important to select the option 'I want to print all 
records from the table.' By default each record is printed once on the label. 

Print Selected Database Records 
You can define which records from the database you want to print in the Records Printing of 
the Database Wizard. 

1. Follow the steps in the chapter Link to a Database Using Database Wizard until the 
step 5. 

2. Select the option I want to select which record to print to be able to select which 
records are printed. 

 
You will be able to select which records are printed 

3. Click on the Finish button. 
The link to the database is created and text objects linked to the variables are 
positioned on the label. 

4. Click on  to open Print dialog box. 
The button Select Records... becomes available. 

5. Click on the button Select Records... 
The Record Selection dialog box opens. 

6. Tick the records you want to print. 
You can select individual records or group of records by selecting the first record, 
press and hold the Shift key and then select the last record in the series. 
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Note: 
Selecting of multiple records is only available when using real databases and not when 
using data from spreadsheets like Microsoft Excel or text CSV data files. 

 
Selecting records for printing 

Query and Create a Database Filter 
Label Gallery software allows you to perform queries on the database table to extract only the 
records matching some condition. Please note that you have to enable record selection in the 
database properties to be able to query the database. To enable database filter, do the 
following: 

1. Refer to the chapter Link to a Database Using Database Wizard. Follow the steps 
from 1 to 6. 

2. Select the option I want to select which record to print. 
3. Click on the Finish button. 

The link to the database is created and database fields are linked to text objects on the 
label. 

4. Click on the  button or select the command Print in the File menu. 
5. Click on the Select Records button in the Print dialog box. 

Record Selection dialog box opens. 
6. Click on the small arrow button next to the field names in the table and choose the 

condition. 
 
Defining the filter by clicking the arrow button 

You can display only the records that are equal to the selected value in the list or you can 
define your custom filter. 
All records matching the condition will be filtered from the database and displayed in the 
table. 

Note: 
You can define conditions on multiple fields at the same time. 
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Linking a Label to Text Databases 

Connect to a Database 
Label Gallery software offers a Database Wizard that guides you through the necessary steps 
to connect the database to a label. To connect your label to a database using the Database 
Wizard, do the following: 

1. Click on the  button in the Standard Toolbar. 
2. Click on the Browse button and point to the text database "C:\Program 

Files\Sato\Gallery2\Samples\Database\data.txt".  

 
Selecting the text database 

3. Click on the Next button. 

Note: 
If you connect to the database for the first time, you need to define the database 
structure. Continue with the next section. 

Format the Data with the Text File Wizard 
Because the text files do not contain the structural information like real databases do, you 
must define the fields and their data structure. When you use the same text database some 
other time, you won't have to define the structure again. 

1. Choose the data type for the selected text database. The fields are aligned in columns, 
so you must select the option Fixed.  
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Defining the type of the text database 

2. Click on the Next button. 
3. Define the widths of the individual columns by placing a break line before the second 

column and before the third column. 

 
Defining the fields in the text database 

4. Click on the Next button. 
5. Accept the default field names and click on the Next button. 
6. Review the text database structure. The field names and their maximum lengths are 

displayed. Click on the Finish button to close Text File Wizard. 
The link to the database has been created and database fields are available on the label.  
Label Gallery software brings you back to the Database Wizard. 
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Overview 
Text databases are text files containing data values that can be used for variable objects on the 
label. The text database is not a real database. It contains the data values but lacks the 
information of the data structure, name of the fields and maximum lengths of the fields. You 
have to provide the missing information before Label Gallery software can use the data from 
such a text database. 

 
The label in design mode (on the left) and preview of the five labels with data from the database 

Place Database Fields on a Label 
The next step in the Database Wizard opens the dialog box with the list of available fields 
from the database.  

1. By default all fields from the database will be used on the label. Click on the Next 
button. 

 
Using all fields in the text database 

2. Specify what records and how many you want to print: 
Select the options I want to select which record to print and I will enter label 
quantity for each selected record. Before printing labels, the table with the records 
will open and you will be able to select the records you want to print and the quantity 
of labels for each record. 
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Specifying which records from the database will be printed and in what quantity 

3. Click on the Next button. 
4. Select if the Database Wizard should link all selected fields from the database to the 

text objects on the label or if you want to link the fields manually to the label.  
5. Click on the Next button.  
6. Select I want a text object for each selected field and click on the Finish button. 

 
Each field from the database will be linked to a text object 

The label will show several text objects. Every field from the database is linked with the text 
object on the label. 

Print a Label 
When you are certain that the label design is correct and label preview shows the correct 
values from the database, you can start sending the labels to the printer. To print a label, do 
the following: 

1. Click on the print icon  in the Standard Toolbar. 
The Print dialog box will open (same as the print preview dialog box). 

2. Click on the button Select Records and select the records you want to print and 
specify the label quantity for each record.  
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Selecting records and specifying label quantity 

3. Click on the OK button. 
4. Click on the Print button to start printing labels. 
5. Click on the Close button to close the dialog box. 

Use Print Preview to Select Data and View a Label 
Now you will simulate label printing using print preview. 

1. Click on the print icon  in the Standard Toolbar. 
2. The Print dialog box opens with the Quantity of labels set to Variable quantity 

(entered for each database record). This setting corresponds to your selection in the 
Database Wizard when you have selected the options I want to select which record 
to print and I will enter label quantity for each selected record. 
 
Only the records you select will be printed in the defined quantity. 
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Print / Print preview dialog box 

3. To choose which records to print from the database click on the Select Records 
button. The Record Selection dialog box will open. 

4. Select the records from the database you want to print and enter the number of labels 
you want to print for each selected record. 

 
Record selection dialog box 

5. Click on the OK button. You will return to the Print dialog box. 
6. Click on the Preview button. Now you can preview the labels on the screen. Note that 

the text objects on the label change for each new record. 
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Preview of the second label in the series 

7. Click on the Next button in the command window to advance to the next label in the 
series. After you see the last label in the preview series, Label Gallery software will 
re-open the Print dialog box. 

8. Click on the Close button to close the Print dialog box. 

Using Database Wizard 

Adding the Fields to the Label 

 
Database wizard – Adding fields to the label 

On this page you specify if you want the wizard to generate text objects on the label that are 
already linked to the corresponding fields in table. Text objects are created in upper left 
corner of a label, but you can later move them to another position. 
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Finishing the Process with Database Wizard 
The summary of tasks you have completed will be shown in the last step of the Wizard. If you 
are satisfied with your selection, click Finish to complete the process of creating a new 
database access function. 

Selecting Database File 

 
Database wizard – Selecting database file 

Enter the full path name of the database file in edit box or use Browse button to find the file 
on your computer. 
Note that you can only select databases that are stored in files. If you use databases via ODBC 
or OLE DB drivers, you will have to set that manually in Database dialog box. 
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Selecting Desired Fields 

 
Database wizard – Selecting fields 

On this page you can select the fields you want to use on the label. All fields in a table are 
selected by default, but you will probably want to de-select some of them, especially if you 
have large table. Variable will be created for each selected field and can later be attached to 
objects. 

Selecting Variable Quantity from the Database Field 
Select a field in the database that contains the label quantity information. The database record 
will be printed on as many consecutive labels as the selected field contains. 

Note: 
Make sure to select the field that has been formatted with the numeric data. 
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Selecting Which Records will be Printed 

 
Database wizard – Selecting which records will be printed 

Select the desired option how you want to use the records in the database. By default the 
option I want to print all records from the table is set and all records in a table will be 
printed one at a time. Each record will be printed only once. 
If you do not want to print the entire database, you can select which records should be printed. 
In this case select the option I want to select which record to print. Prior printing you will 
be shown a dialog box with all records from the database. Then you will be able to select 
which records should be printed. 
By default records are used once for a single label. If you would like to print several copies of 
a label with database data, you can define it in the second part of this step of the Wizard. 
A field in table contains quantity to print option will let you chose some field in the 
database. This field has the information about the quantity of labels for each record. 

For example: 
You have database with records of your products. It contains a field with a numeric 
value, where the required number of label copies is stored. Select this field and let the 
application print the quantity of labels specified here. 

I will enter print quantity for each record: This option is only accessible if you have 
defined to select which records should be printed. Prior printing you will be able to select 
which records will be printed in the selection dialog box. At the same time you will be able to 
type in the exact label copy for each selected record.  
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Using Database Wizard 
Process of defining a new Database access function consists of four steps (pages). On those 
pages you enter the data required by Wizard. You can go to the next step (page) by clicking 
Next button or return to previous with Previous button.  
When all data needed has been entered, Finish button will become available, allowing you to 
complete the process of defining a new Database access function. Note that some options 
have predefined values, so you don't really need to go through all the steps of a wizard. 

Using Text File Wizard 

Choosing Data Type 
Before you can use text file, you will have to define its data structure. Fields can be delimited 
by some sort of a separator (tab, semicolon, comma or some entirely user-defined separator) 
or can be of a fixed length. 

 
Database Wizard –Choosing Data Type 

Choose Delimited, if you know that data fields are separated with some special character. File 
preview at the bottom of the dialog box can be helpful, if you do not know exactly how the 
data is organized. 
Choose Fixed if you know, that your data fields always occupy the same number of 
characters. 
Start import at row option is useful, when you do not want to import some rows at the top of 
the file. Most usual situation, when you would want to use this option is when text file 
contains some header on top of actual data fields. 
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Formatting the Fields 

 
Database Wizard –Formatting the fields 

In this step of the Wizard you can review the fields' names and lengths and modify them, if 
necessary. You will probably use more friendly field names, so you can distinguish between 
them more easily. 
When you are finished with Text File Wizard, the structure information of the used text file is 
stored to a separate file with a extension of .SCH (Scheme File). If you will try to use the 
same text file some other time on a different label, you will be spared all efforts of structure 
creating. SCH file will be automatically used and Text File Wizard will be skipped entirely. 
Note, that SCH file is created also with add-on database manager GalleryData, when you 
open the text database in GalleryData for the first time. 
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Setting the Fields 

 
Database Wizard –Setting separator and delimiter 

In the second step of the Text File Wizard you have to set the fields in the text file. If you 
have selected Delimited in the previous step, choose the appropriate separator here. The ones 
that are usually used with text files are already pre-defined. But if you require some other, 
there is an option to use a custom-defined one. 
You can also select the Delimiter character that is used when separator character is used in the 
text field itself. The delimiter should be used to enclose such field. Text between two 
delimiter characters is treated as one field although it contains the field separator character. 
The data preview in the bottom part of the dialog box will let you know if your choice of a 
separator character is a correct one. Fields will be separated with vertical lines, if a separator 
is valid. 
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Database Wizard –Setting column breaks 

If you have selected that your data is formatted with fixed widths, the second step of the 
Wizard will be slightly different. Instead of selecting character for field separation, you will 
have to define field widths. The Wizard makes is as simple as possible. Use a mouse and 
draw a vertical line to the start positions of the fields. Lines will indicate where the new field 
starts. 

Text File Wizard 
When the input database file is a plain ASCII text file or formatted CSV (Comma Separated 
Values), Text File Wizard will be started within Database Wizard and it will guide you 
through quick and easy steps of text data acquire. The main difference between real database 
and text file is in their data structure information. Databases include the whole information 
about their fields (names, data format, length) and can be automatically used with the 
application. Text files, on the other hand, do not have stored such information and you will 
have to instruct the application how the data is encoded. 
When Text File Wizard finishes, it will return control back to Database Wizard, that will 
guide the rest of the way. 

Database Access 

Database access functions are functions used to retrieve data from the database. 
The records can be obtained from the database using different approaches. 

1. You can successively read record by record from the database and use them all on the 
label. 

2. You can select records for printing. 
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3. You can define filters that will be used to retrieve just a subset of records from your 
database, that will comply to your conditions. 

The result of the database access function is a set of variables, one for each selected field of 
database table. Each database variable is named the same as the database field, but has 
additional prefix of a database name. This allows you to quicker identify from which database 
table the variable comes from. 

For example: 
If you have a field name Product in the database table DBPROD, the resulting label 
variable will be named DBPROD.Product. 

Label Gallery software supports all types database. The only condition is that you have the 
appropriate database driver installed in the Windows system. Label Gallery can work with 
OLE DB, ODBC, BDE and other database drivers. 
For connectivity to modern multi-lingual Unicode databases the OLE DB provider is 
available. Using this technology the Unicode values can be used on the label. These are the 
data values in different codepages. You can use the tables with different language settings on 
the same label. 

Quickly Editing Database 

Click the  icon in the Database toolbar. The application GalleryData will open the 
currently selected database.  

Note: 
GalleryData must be installed on your computer. 

Read Data from the Database 

You must use the database access function to read data from database.  
Create a new connection to the database using either of the two methods below: 

• Clicking the "New database wizard" button  on Database toolbar 
• Selecting Database access from Data menu and clicking on the Wizard button. 

Follow the on-screen instructions until the Database Wizard finishes. 
For every field in the table, you now have a text object on the label. Each database field is 
available as a variable on the label. 
If your database type is not available in the Wizard or you want to use different driver (OLE 
DB provider) for connection to the database, you will have to use direct database set-up 
option and not the Database Wizard. 

Using ODBC Databases 

To be able to use ODBC databases, you first have to setup your ODBC drivers properly. You 
can do this in advanced by starting ODBC setup program in Control Panel and modifying 
Data Source Names (DSNs) to suit your database file locations. Or you can do the same thing 
from Label Gallery software. 
Connection to already defined ODBC data sources can be done using the Database Wizard. 
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If data source is not defined in the system yet, you will have to use direct connection method 
and by pass the Wizard. 

1. Open Database Access dialog box, then click the Define button in General tab. 
2. In the list of database connection types first find the OLE DB drivers, then ODBC 

Data sources. 
3. In the right side of the dialog box select already prepared data connection or create a 

new one. 
4. Once you have the ODBC data connection prepared, select it and close the dialog. 
5. The fields from the selected database can now be used on the label. 

Working with Functions 

Defining a Function 

Define a Function 
When you want to define the first function, the list of functions will be empty and, you must 
click the New button to define the function. The Function dialog box is then displayed. 

 
Function dialog box – General tab 

This dialog box is also displayed when you want to change the existing function. 



Designing Labels 

133 

To define (change) the function all required parameters must be entered and confirmed by 
clicking OK button. 
Dialog box has several pages – tabs. Note that only General tab is fixed, all other tabs change 
according to the function type you select on General tab. Each other tab is described 
separately for each function. 

Using Functions to Manipulate Label Data 

Using Concatenate Function 
The concatenate function merges two or more variables into one new variable. To create a 
concatenate function, do the following: 

1. Click on the   button in the Standard toolbar or select Open in the File menu. Select 
the label file ID_CARD.LBL from Label Gallery sample folder "C:\Program 
Files\Sato\Gallery2\Samples\Labels". 
The label has a link to the database so you see how the concatenate function operates 
on a set of records. 

2. Select the command Functions in the Data menu. 
3. There is already one function defined in the label. Ignore it and click on the New 

button. 
The dialog box with the properties of the new function will open. 

4. In the General tab type 'My Concatenate function' for the name for the function. 
5. Select the Concatenate function from the list of functions. 
6. Click on the Detailed tab to define details for the function. 

Look at the top of the dialog box. The left side contains the available variables defined 
on the label. 

7. Select the variables ID and NAME. Note that they have appeared in the right list box. 
8. The name of the output variable is 'Concatenate' and delimiter is set to 'None'. Click 

on the OK button. 
 
Definition of the Concatenate function 

9. Click on the Close button to close the Functions dialog box. 
10. The function-generated variable is defined on the label. You should link it to text 

object on the label. 
11. Click on the small arrow next to Text Object in the Toolbox. 
12. Click on the option Use existing variable and select the variable Concatenate.  
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Selecting the function-generated variable Concatenate 

13. Click on the label where you want to place the text object. The text object is linked to 
the new variable Concatenate. 

The values of variables 'ID' and 'NAME' are merged and saved to the function-generated 
variable 'Concatenate' every time the label is processed for preview or print. 

Using Functions to Manipulate Label Data 
Label Gallery software enables you to work with variable values on the label, manipulate the 
values and use them with other label objects. Label Gallery software offers a group of 
functions that help you work with the variable values. There is always some input to the 
function that the function manipulates and always some output that is stored to a function-
generated variable. The function-generated variable can be linked to label objects or used in 
other functions. 
There are many Label Gallery functions available, such as Concatenate (for linked fields), 
Subset, Date addition, FACT, HIBC and Visual Basic script. Visual Basic script is a powerful 
function allowing you to perform advanced data manipulation. 

Using Visual Basic Function 
Visual Basic function allows you to perform the most demanding and difficult data 
manipulation on the label. Available are all the functions, procedures and operands from 
Microsoft Visual Basic script. Your script can take values from all label variables, work with 
the values and save the result in a function-generated variable. To create a visual basic 
function, do the following: 

1. Click on the button in the Standard toolbar or select Open in the File menu. Select 
the label file ID_CARD.LBL from Label Gallery sample folder "C:\Program 
Files\Sato\Gallery2\Samples\Labels". 
The label has a link to the database so you see how the concatenate function operates 
on a set of records. 

2. Select the command Functions in the Data menu. 
3. There is already one function defined in the label. Ignore it and click on the New 

button. 
The dialog box with the properties of the new function will open. 
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4. Type in the name for the function, for example 'My Visual Basic function'. 
5. Select the Visual Basic Script function from the list of functions. 

 
Select the Visual Basic Script option 

6. Click on the Detailed tab to define properties for the function. 
The variable NAME on the label provides the first and last names of the person. The 
Visual Basic script should break them apart and use only the first name as the result of 
the function. 
 
For the Visual Basic script enter the following code: 
Dim Spc 
Spc = InStr(NAME, " ") 
if NAME <> "" then 
Result = Mid(NAME, 1, Spc-1) 
end if 
 
The above script will search for the first space in the variable NAME and save all 
characters until this space character as a result. 

Note: 
Refer to the online help or User Guide for more information about Visual Basic Script 
functionality. 

7. The result from the Visual Basic Script function is automatically stored in the 
function-generated variable (VBScript1) every time the label is processed for preview 
or print. 

8. Click on the OK button. 
9. Click on the Close button to close the Functions dialog box. 

To link the function-generated variable VBScript1 to an object on the label, do the following:  
1. Click on the small arrow at the right end of the Text object. Click on the option Use 

existing variable and select the variable VBScript1.  

 
Selecting the function-generated variable VBScript1 
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2. Click on the label where you want to place the text object. The text object is linked to 
the new variable VBScript1. 

Every time the label is processed for preview or print the Visual Basic script will re-calculate 
the result and store it in the function-generated variable VBScript1. 

Working with Memory Cards 

Using the Printer Memory Card 

Usage of printer memory card is recommended whenever faster label printing is required. A 
memory card boosts performance because there is no need to transfer large bitmap images or 
custom font files to printer over and over again. Every element that is needed on the label is 
already stored on the memory card. 
Let's take a look at how you can prepare and use your memory card. 

1. First of all, go through the user manual of your memory card. Memory cards are 
sensitive devices and misuse could damage the card as well as your printer. 

2. Insert memory card into Slot 1. The slots are usually located at the back of the printer. 
Switch on the printer. 

3. Start the application GalleryMemMaster, memory card manager. It is part of the Label 
Gallery Plus & TruePro editions. If the icon for GalleryMemMaster is not shown in 
the folder Label Gallery in the Start menu check your installation. Reinstall Label 
Gallery Plus or TruePro if necessary. 

4. We'll assume that memory card is empty or safe to delete. First step is, to let 
GalleryMemMaster know what type of card is inserted in printer. Click Print Setup 

in Card menu. Select your thermal printer from the list. If your printer is not 
listed, you will have to install the appropriate GalleryDriver. Click button Properties 
then click button Memory to open dialog box Printer memory. Here we have to 
activate the memory card in Slot 1. Look at section Slot 1. In field Type select 
Memory Card, leave field Connected file intact. Keep clicking OK until you return to 
GalleryMemMaster. 

Note: 
GalleryMemMaster works only in conjunction with GalleryDriver. 

5. We will format the memory card and prepare it for downloading our data. Be careful, 
if the card contains any previously downloaded elements, they will be deleted. Click 
Format from Card menu or click . Formatting will take a few seconds. 

6. Next step is to build a list of fonts and graphics that we want to store on memory card. 
The information about these fonts and graphics is stored in memory card file (.MMF). 
Let's make a sample memory card file. Select New from Card menu, or click . 
Name the file Sample and click OK. In dialog Card setup type in description and 
select proper card size in kilobytes. You can always return to this dialog by selecting 
Memory card information in Card menu or clicking . 
On the left side of the GalleryMemMaster windows is place for inserting fonts; on the 
right side is a place for graphics files. To add a font select Add from Font menu or 
right-click Fonts side of the window. Select font to be downloaded and its style and 
size. Next dialog allows you to select only the required characters in this font. Only 
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selected characters will be downloaded to memory card. Use this option if you are 
running low on kilobytes on memory card. Let's add the whole font in our sample. 
Next we we'll add some graphics to our list. Select Add from Graphics menu or right-
click Graphics side of the window. Select some pictures (e.g. SAMPLE.PCX or 
PRINTER.BMP, these are installed together with the Label Gallery software 
packages). 
In the lower part of the window you can see information about selected font or 
graphics: preview, used memory, width and height. Every element can be printed to 
label, just to see if everything is all right. Use command Test print. Add some more 
fonts and graphics to get a grip. Undesired elements can be removed from the list. Use 
Delete from Font/Graphics menu or right click the element and select Delete. 

7. When layout is complete and every font and graphics is in the list, we are ready for 
download. You can download the whole list to the printer at once. Right-click left or 
right side of the window and select Download All from the list. Or you can download 
one element at a time by selecting it and clicking Download from Fonts/Graphics 
menu or right clicking it and selecting Download from the list. If for some reason you 
want to remove a downloaded element from memory card, but keep it in the list for 
later, use command Remove. 
Now let's do a status print. Printer will report some useful information of memory card 
usage. Click Status Print from Card menu. 

Memory card is now filled with elements (fonts and graphics) and is ready to be used from 
Label Gallery. 

1. Start the application Label Gallery Plus 

2. Create new label. Click New from File menu or click . Choose your printer from 
the list. Select predefined label stock or design your own label. 

3. We have to tell Label Gallery that our printer is equipped with memory card and what 
kind of data is stored on the memory card. 
Double-click the printer name in the status line in the bottom of the window. Click 
button Memory, and in section Slot 1 for Type select Memory Card and for 
Connected file select SAMPLE. This is the name of the memory card file (.MMF) we 
created before. Click OK to return to Label Gallery. 

4. Using downloaded font. 
Click Text icon  or Paragraph icon  and type in some 
text. From text toolbar select the font, you downloaded to memory card before. If text 
toolbar is not shown on your screen, switch it on using command Text tool in View 
menu. You will recognize downloaded font by special printer symbol in front of its 
name . To make sure, you have selected the proper font, the same symbol is shown 
in the lower right corner of the element on the label. If the symbol is not there, you 
didn't select the right font or you do not have switched on displaying of printer 
element. In this case select Object properties in View menu and click Printer 
elements. 

5. Using downloaded graphics. 
Click Graphics icon  and select the picture you downloaded to 
memory card before. Click OK. Inserted picture is used from disk and not from 
memory card yet. To change this double click the picture and select On memory card 
in General tab. Click Browse and select the picture from memory card. To make sure 
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you are using picture from memory card look at the picture on the label. It should be 
framed in blue box. Regular picture doesn't have any frame. 

If you need further explanation on how GalleryMemMaster works please refer to 
GalleryMemMaster documentation. 

Working with Variables 

Using Variable Wizard 

Variable wizard 
The variable wizard simplifies and speeds up the creation of the most common types of 
variables. You cannot however set the advanced options in variables. These can only be set in 
a Variable dialog box. 

 
Variable Wizard - Choosing the type of variable 

First you must type in the variable name and select the type of variable. You can chose 
among: 
Keyboard 
input 

The value of the variable will be typed 
in before printing. 

Counter The variable will automatically 
increment when the labels are printed. 

Date field The value for the variable will be 
current date (optionally with offset). 
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Time 
field 

The value for the variable will be 
current time. 

 
Generic variable name based on the type of a variable field selected will be auto-generated, 
but you should change it to a more descriptive name. Use the name that will clearly on first 
sight determine the contents of this variable. 
When all data, that wizard needs are provided (you click the Finish button), the text with 
variable content will be inserted at the specified point of the label. You can later edit the text 
object and variable itself just as any other text and variable on the label. See Text command 
and Variable dialog box above for further information. 

Variable Wizard - Counter 
On this page of the variable wizard, you define the counter variable. 

 
Dialog box for Variable Wizard when Counter option is chosen 

Starting Value: Set the starting value for the counter. The counter will increment or 
decrement from the starting value. 

Note: 
You can enter only digits for the starting value. 
  

Prompt for value before print: Tick this option to enable entering the starting value of the 
counter when you start printing labels. Enter the text that will be shown to the user before 
printing. 
The message will be shown on the screen each time when the label is to be printed.  
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Set maximum number of digits: Define the maximum length of digits the counter can 
occupy. 
Increment or decrement: You can define that the variable value will increase from label to 
label, or decrease. 
Preview: The field shows the preview of the counter, based on your selection. 

Variable Wizard - Counter Continuation 
Step: Define the step for your counter. The counter will increase by this number on every 
label. 
Change value every <n> labels: Define the number of labels, when the counter will change 
the value. 
Rollover when reached: Enter the value, when reached, will cause the counter to reset the 
value to the starting value. 

Variable Wizard - Date Field 
Define the properties of the date field. The variable field will get the value from a computer 
clock. 

 
Dialog box for Variable Wizard when Date field option is chosen 

Format: Select the format for your date from the list. You can also enter the custom format. 
Date offset: You can add a certain numbers of days, months or years to a current date and 
print that date instead of the current one. 
Preview: The printer will print the date as shown on the Preview field. This way you can see 
how the selected date format will look on the label. 
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Variable Wizard - Keyboard input 
Use this variable type when you want the operator to enter a value of the variable from the 
keyboard before printing the specified numbers of labels. 

 
Dialog box for Variable Wizard when Keyboard input option is chosen 

Prompt text for this variable field: Fill in the message that will be shown to the user when 
he will enter tne values for the variable field. 
Format: Select the format of data you allow to be entered for the variable field. 
Set maximum number of characters: Define the maximum length of characters that can be 
entered for the variable field. 

Variable Wizard - Prefix and Suffix 
The variable element can have a prefix and suffix values. The prefix text is placed in front of 
the variable's value. The suffix text is place at the end of the variable's value. 

Note: 
If you leave the edit fields empty, the prefix/suffix will not be used. 

Prefix and suffix can be used in situations where they are required only if the variable has set 
some value. If the variable is empty, the prefix/suffix will not be printed as well. 

Variable Wizard - Time Field 
Define the properties of the time field. The variable field will get the value from a computer 
clock. 
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Dialog box for Variable Wizard when Time field option is chosen 

Format: Select the format for the time from the list. You can also enter the custom format. 
Preview: The printer will print the time as shown on the Preview field. This way you can see 
how the selected date format will look on the label. 

Available Data Types 

Here you can define the input format and output format of the variable. 
Supported format types are: 
None This format is used when you don't need any 

special format. 

Date This format is used to insert the date. Input and 
output pictures can be set. Allowed values for 
input are shown in drop-down list. More on date 
inputting can be found in section Variable 
Wizard - Date Field. 

Time This format is used to insert the time and is 
similar to date inserting. More on time inputting 
can be found in section Variable Wizard - Time 
Field. 

Floating 
Point 

This format is used to insert large numbers. This 
type enables you to put comma and points in the 
right places. 
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Money This format lets you choose the currency unit, 
and put it on the correct place. 

Pick 
List 

This format enables you to define a list of 
values for the input values. Entered entries in 
the pick list are available to the user in the 
combo box that is displayed when the label is 
printed. The user can select one of the pre-
defined values. 

Binary This format enables the insertion of a binary 
value on the input. The output is ASCII 
character. 

Available Date Formats 

The date fields can be printed in various formats. In this field you define, how the date will 
look. You can select some of the predefined date formats or enter you own. When defining 
the formats, the following notation is used: 
D Number of the day in a month. Can occupy one or two characters. 

DD Number of the day in a month. Always occupies two characters. (leading 
zeros will be added as necessary). 

M M is number of the month. Can occupy one or two characters. 

MM MM is number of the month. Always occupies two characters. 

YY or 
YYYY 

The year as 2 or 4 digits number. 

DDD Abbreviation of the day of week name. 

DDDD The full day of week name. 

MMMM The full name of the month. 

MMM The abbreviation of the name of month. 

J The number of days since 1. January. Can occupy from one to three 
characters. 

JJJ The number of days since 1. January. Always occupies three characters. 

W The week number in current year. Can occupy one or two characters. 

WW The week number in current year. Always occupies two characters. 

 Any other sequence of characters will be displayed unchanged. This way you 
can insert dots, commas and other characters needed to properly write the 
date. 

 
The examples: 
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Format How the date will look 
D/M/YYYY 10/3/2005 
DD/MM/YY 10/03/05 
DDDD, D. MMMM YYYY Thursday, 10. March 2005
JJJWWYYYY 069102005 

 

Available Time Formats 

The time can be printed in various formats. In this field you define, how the time will look. 
You can select some of the predefined time formats or enter you own. When defining the 
formats, the following notation is used: 
h Hours in 12-hour format (AM/PM will be added if they follow the time). Can occupy 

one or two characters. 

hh Hours in 12-hour format (AM/PM will be added if they follow the time). Always 
occupies two characters. (leading zeros will be added as necessary). 

H Hours in 24-hour format. Can occupy one or two characters. 

HH Hours in 24-hour format. Always occupies two characters. 

mm Used for minutes. 

ss Used for seconds. 
 
The examples: 
Format How the time will look
h:mm {AM/PM} 8:25PM 

H:mm 20:25 

hh:mm:ss 08:25:36 

Changing the Order of Entering Prompted Variables 

When you are using variables, value has to be assigned to them before printing. And one way 
of doing this is by using prompted variables (other are counters, functions, databases, ...). You 
are asked for the value of every prompted variable before every printing. Then you fill in the 
values. The order in which you are entering the values may or may not be the order you want. 
If it is not it's probably the best solution, to change it. 
The order can be changed in Variables dialog box. 

1. Click Variables in Data menu to display a dialog box. All variables you are using are 
listed here alphabetically. 

2. Click the button 1, 2, 3, ... in the lower right part of the dialog box. 
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3. Prompt order dialog box pops up. This is where you can change the order in which 
you are entering values to variables. Select the variable from the list on the left and 
roll it to appropriate position using buttons Up and Down. Repeat the procedure for 
every variable, that needs its position changed. 

Creating a Prompted Variable 

1. Create a new variable. Instructions for this step can be found in how-to topic Create a 
serial number, counter. 

2. Name the variable "Prompted". Set the length of the variable. 
3. Go to the Prompting tab. 
4. Type in the Display this text to the print operator field the content "Please enter a 

value". 
5. If you want to be prompted for every label that is printed, change setting to Every to 

1. 
6. If you want the variable to have a default value, go to the Prompting tab. If you do 

not want to be prompted for value at print time, change the mode to Do not prompt 
for value. The variable will behave like a constant. 

7. Click the OK button and link the variable with text or bar code. 

Creating a Serial Number, Counter 

The easiest way of creating new variable is using Variable Wizard. 

1. Click the arrow button in the button  on variable toolbar to start Variable 
Wizard 

2. From drop-down menu select Counter as the type of the variable, set the name of the 
counter and click Next 

3. Type in Starting value and you are finished with setting up this simple counter. 
However, using Variable Wizard you are also capable of changing other properties of the 
counter: prompt for value before printing, maximum number of digits, step of 
incrementing/decrementing and much more. 
The other method of creating counter is by creating a new variable directly (not using the 
Wizard) and then setting its parameters appropriately: 

1. Click on the button New variable  on variable toolbar or 
2. Click command Variables in menu Data and press New button. 
3. Name the variable e.g. "Counter". Set the length of the variable. Go to the 

Serialization tab of the dialog and set the parameters: 
• Incremental/decremental counter 
• Step - value of the variable will be increased in steps 
• Change value after the number of labels 

If you want to make counter filled in with leading zeroes, do the following: 
1. Go to the Data Processing tab. 
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2. Set Position relative to the variable value to On left. 
3. Type 0 for the Character.  

If you want the variable to have a default value, do the following: 
1. Go to the Prompting tab. 
2. Enter the value into the Default value field. 

Note: 
If you do not want to be prompted for variable value at print time, change the option 
Prompt to Do not prompt for value. The counter will always start counting from the 
default value. 

Press on the OK button and link the variable to text or bar code. 

Make a Counter that Preserves Last-used Value 

Counter which preserves last-used value is applicable in cases when continuing of numbering 
from last label production is required (e.g. serial number). The last value of the counter that 
was used on the label is stored and the numbering is continued from this point at next use. 

1. Create a new variable. Instructions for this step can be found in how-to topic Create a 
serial number, counter. 

2. Name the variable e.g. "Counter". Set the length of the variable and Format to 
Numeric. Go to the "Increment" page of the dialog and set the parameters:  

• Incremental/decremental counter 
• Step - value of the variable will be increased in steps 
• Change value after the number of labels 

3. Go to Prompting  tab, select the option Prompt and enter the Default value you want 
to use as the starting value for the counter. 

4. Then tick the option Remember last used value (dynamic value). This will enable 
the counter to remember the last used value. 

Note: 
The counter which preserves last-used value cannot be made with Variable wizard, but 
only using dialog for adding new variables. 

The last used value is stored in the same folder, where the label is. The file extension with last 
used value is .DVV, the filename is the same as the label. 
Last-used values are stored in the external text files in the same folder where the label resides. 
The external files have the same filename as the label file, but the extension .DVV. The label 
file does not have to be saved to store the dynamic values. If you use labels with dynamic 
values and exchange them with other users, make sure to exchange not only label files (.LBL) 
but also files with last used dynamic values (.DDV). 

Note: 
If you want to use the counter that remembers last-used value, you must have the 
permissions to write in the folder with the labels. 

This type of a counter will remember the last value that was used for it on this label. If you 
want to share the same counter on many labels and it should progress no matter which label is 
printed, look at the global variable. It too can remember last-used value and can be used on 
different labels. 
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Global Variable 

Global variable is a type of variable that can be used on many different labels. Once it is 
defined, it is stored outside the current label so it is available for any other label as well. 
Its last value is stored even after closing the label file and exiting the application. It is useful 
when continuing of numbering from previous printing is required. Values of global variables 
are stored in a separate file on disk GLOBALS.TDB. 
The location of the folder varies depending on the Windows operating system used. On 
Windows 98 and Me the location is C:\Program Files\Sato\Gallery2\Bin\System, on Windows 
NT, 2000, XP and 2003 the location is C:\Documents and Settings\All Users\Application 
Data\Sato\Gallery2\System. 
Global variable is an advanced option for power users, and is not available in the Variable 
wizard. Global variable can only be created manually in the Variable dialog box. Make sure to 
select Global as the Source for the variable in the General tab. 
If you copy your label file, which uses global variables to another computer, you have to copy 
the file GLOBALS.TDB to the new computer as well. If you miss this step, then the labeling 
application won't find appropriate global variable and will notify you of this situation. At the 
same time a substitute global variable will be created, but last value of old variable will not be 
known, nor will the correct variable properties be restored. Check the settings of substitute 
global variable and change them appropriately to suit you needs. 
The same global variable is not limited for use on only one label. You can use it on as many 
labels as you like. Please note, that only one label, using the same global variable, can be 
printed at a time. When using global variables, they are locked for one label and this prevents 
more labels to use the same global variable at the same time. 

Groups of Allowable Characters 

The format of a variable is selectable to filter the input data. This helps avoiding mistakes 
when entering data. You can only enter characters, which are included in the specified format 
range. 

All Select this format when there is no need to 
limit the variable data. For example: one 
variable can be used to define changes in the 
bar code, the text and the graphics. You can 
enter all characters from the keyboard. 

Numeric Use this format you need numeric variables, 
for example, serial numbers or EAN and UPC 
bar code. Only numeric characters in the 
range 0 to 9 can be entered. 

Alphanumeric Use this format when numbers and characters 
are mixed in the same variable - for example, 
identity codes... Characters from 0 to 9, a to z 
and A to Z can be entered. 

Letters Use this format when you need the character 
variable. 
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7-bit ASCII 
format 

The variable will contain only characters with 
ASCII code from 0 to 127. 

Hex Use this format to allow input of hexadecimal 
numbers. 

Date Use this format to print date stamp. 

Time Use this format to print time stamp. 

Digits and 
Capitals 

Use this format to limit the usage only to 
digits and capitals of English alphabet. 

CUSTOM You can define your own data format. The 
allowable characters can be defined in the 
Serialization tab. 

<printer 
family name> 
FORMAT 

Use this formats do enable usage only of 
characters that are allowed in the internal 
fonts of the currently selected printer. 

Code 39, 
Code 128A, 
Code 128B, 
Code 128C, 
Code 128, 
Codabar 

Use this formats to enable usage only of 
characters that are allowed by these bar codes 
standards. 

 

Internal Variables 

Internal variables are filled automatically by the software and you do not have any influence 
on them. They cannot be edited and modified, but only used in the functions and on the label. 
Their value is updated for every printed label. 

Internal variables are represented with the  icon so they can be easily distinguished from the 
other types of variables. 
The list of available internal variables: 
ComputerName Contains the information about the computer name of a PC 

computer where labels are processed, as specified from Windows 
system. 

CurrentBatchQuantity Contains information about the label quantity reached in the 
current label batch. 
The value is reset at beginning at each batch in the printing 
process. 

DefaultPrinterName Contains the name of the default printer on the system. 

LabelFileName Contains full name of the current label, including the path to the 
file. 
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LabelPrinterName Contains the name of the printer that is used on the label. 

RequestedQuantity Contains the quantity of the labels as specified by the user or 
external application. 

ShortLabelName Contains the name of the label without the path. Only filename 
with the extension LBL is available. 

SystemUserName Contains the name of the system Windows user that is logged in 
and is running the application. 

TotalQuantityPrinted Contains the quantity of all unique labels printed. Label copies 
are not included in this variable, only the number of different 
labels is. 

UserName Contains the name of the Label Gallery user that is logged in and 
is using the application. This variable has some value only when 
you have enabled user management in the software. 

 

Types of Variables 

Each type of variable has its own icon to easier distinguish variables among each other. The 
icon in front of the variable name determines its type. 
The available types of variables are: 

 System Date/Time variable 

 Printer Date/Time variable 

 Counter variable 

 Counter variable with enabled Dynamic Value

 Prompt variable 

 Prompt variable with enabled Dynamic Value 

 Global variable 

 Database variable 

 Function-generated variable 

 Internal variable 

 Locked variable 
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Use Variable Graphics 

At first you have to create a variable that will contain the name of the graphics file. You can 
use Variable wizard to create new prompted variable or use database function to retrieve 
names from database. It is not important where the variable gets the value. 
Hint!When defining variable that will contain the name of the graphics, you can use Prefix 
option to specify the drive and folder where file is located (like C:\GRAPHICS\. Similarly 
you can use Suffix to define file extension (like .BMP. This way the whole path and extension 
of the graphics file will be added automatically, you just have to provide the image name. 
The next step is to connect this variable to the graphics element on the label by selecting 
option Variable in the Contents tab of the Graphics dialog box and select appropriate variable 
from the list below. 

Using Printer Internal Increment Counter 

Almost all thermal printers offer internal increment counter. This is a special printer counter 
that counts labels internally. The printer only receives the first value of the counter and then 
automatically increments the counter in steps of 1 on the subsequent labels. Using this option 
reduces the amount of data transferred between computer and printer as only start value is 
sent to printer. This can significantly speed up label production. 

1. Create a new variable "Counter". Instructions for this step can be found in the topic 
Create a serial number, counter. 

2. To use counter as internal printer element please pay attention to the following 
settings: 

• The variable's maximum length is limited by you printer. You should find this 
value in your printer's Owner Manuals. If you can not find this value, 
experiment. 

• The variable length has to be set to Fixed. 
• The variable format has to be set to Numeric. 
• The text object linked to the variable must be formatted in the internal printer 

font. 
• Tick the option Use printer internal counter in Contents tab of the Text 

element's dialog box. This option is available only if the counter variable has 
been set up properly. 

3. There should be two symbols  in the lower right corner of text box. The first 
one tells that this text will be printed in internal printer font. The second one tells that 
this counters is internal printer increment counter. 

Using Variable Quantity 

Variable Quantity is a special variable in the label. You use this variable, when you do not 
know exact number of labels for printing. Using this variable, you can enter the number of 
labels to print during printing itself. 

The example: 
You have a label of a product. Already defined variables are "Name" and "Price". 

We want to print labels as follows: 
• Enter Name and Price values 
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• Enter quantity for this product 
• Print 
• Start with new product. 

Do the following: 
1. Create new variable, named "Quantity". 
2. Tick the option The variable value is used as label quantity in the General tab. 
3. Edit variables "Name" and "Price". Go to the Prompting tab (assuming, the variables 

are already defined as prompted variables). 
4. Change the Prompt setting to Based on variable quantity. 

When you start printing labels, the quantity parameter in the print dialog is already set to 
Variable quantity (defined from label variable). 

Dynamic Data Overview 

You may want to print labels on which data changes for each label, for example, counters, 
serial numbers, date and time, weight, article pictures… To accommodate the changing data, 
the labeling application can easily be used to format labels using variable data, special 
functions on variables, and databases. 
There are several types of variables you can choose, and functions, which you define, to best 
suit your needs. Data that must be printed as a variable is prepared at the time of printing, and 
can be entered in the program from different sources i.e. keyboard, databases, system clock, 
etc. The variable data can be the same for a quantity of labels or/and specific for one label 
only. 
To understand how variable data is handled, a few terms must be explained: variables, 
functions and database access. 
Variables 
Variables in this labeling application are much like ordinary variables; they simply don't have 
constant value. The basic idea of variables was to allow you to type the variable value just 
before printing the label, but this has expanded a lot. You can now automatically get correct 
value from a database or perform a calculation on existing variables and take the result as a 
variable value. 
A variable also has several properties: its name, type (text, numeric, date…), maximal length 
of value in characters and many more. One other important, but fixed property is the input for 
specific variable (keyboard, database, function, system clock…). 

Functions 
Functions are very powerful tool, which offers almost unlimited possibilities to the user, when 
processing data for the label. The function takes some variables as input, make some 
processing on the data, and return the result in one or more variables that contain new values. 
Complexity of function varies from simple concatenating of two variables to very complex 
manipulation of external data. 
For example, you can use functions to concatenate two strings of data to one if they are 
separate in database like FIRST_NAME+LAST_NAME. You can also do numeric 
calculations on variables. That way you can for example have the weight on a label displayed 
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in pounds, although the weight in database is in kilograms. Using the built-in Visual Basic 
scripting you can add any functionality to the labeling software you can possibly need. 
Database access 
If you have existing database on your computer (or network) you can use that database to 
print labels. Simply create a special database function that gives you variables you can use to 
access the specific records in your database. That way you can completely automate the 
process of printing the labels for your product. 
For example, as new products are created, you fill a special table with serial numbers of those 
products. The application then uses this table as source to print appropriate labels. 
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Printing and Previewing Labels 

GalleryPrint 
GalleryPrint is a standalone application that enables fast and easy label printing. You can start 
it from Label Gallery TruePro program group in Start menu. Using GalleryPrint, you can 
select all necessary printing actions in one single window: 

• Select the label for printing 
• Set the values for variables 
• Select records in the database 
• Change the printer and its properties 
• Define label quantity 
• See label preview 
• Print the label 

 
Application GalleryPrint provides fast access to label printing 

GalleryPrint is available in Label Gallery TruePro edition. 

Optimize the Printing Speed 
There are many factors that affect the printing speed. By following the guidelines below you 
can dramatically increase the speed of printing: 
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• If your printer supports parallel and serial port, use the parallel port. Computer can 
send data to printer over parallel port much faster than over serial port. 

• Use printer's internal fonts instead of Windows' true-type fonts. True-type fonts must 
be sent to printer as graphics and therefore the size of data sent to printer is much 
bigger (couple of kilobytes). When using internal fonts, only the text is sent to printer 
(couple of bytes). If you must use true-type fonts, use the GalleryMemMaster 
program, to download these fonts to printer's memory and later access these fonts as 
internal printer fonts (only if your printer supports this). 

• Avoid use of graphics on labels. If you must print graphics on labels, use the 
GalleryMemMaster program to download these graphics to printer's internal memory 
(only if your printer supports this). 

• When using bar codes, make sure that you don't print bar codes as graphics, if your 
printer supports printing bar codes. 

• When using counters, the printer will internally increment the numbers if the internal 
fonts are used. (if supported by the printer) This means, that the printer will only 
receive the first number of object, and will later increment this number to print other 
labels. Using this option also reduces the amount of data transferred between 
computer and printer, but the difference is noticeable only with high quantity of labels. 

• Set the printing speed to a higher value (if your printer supports it). Note that setting 
the printing speed usually affects the quality of printing. The higher the speed, the 
lower the quality. You will have to find an acceptable compromise for this. 

• Don't print too much data on labels. If the speed of printing is an important factor, you 
should consider using preprinted labels, and only print the data, that is different on 
each label. 

Preview and Print a Label 
If you want to print a label, you can use the print preview to simulate a print output. The label 
preview shows the label on the screen. 
Simulate printing 10 labels on the screen to check label layout and printing procedure. 

1. Click on  icon in the Standard toolbar or select the command Print in the 
File menu. The Print dialog box appears. 

2. Enter 10 for Label Quantity and click on the Preview button. Label Gallery software 
will close the dialog box and simulate the production for 10 labels on the screen. 

Note: 
You can select between the quantity of the labels and the quantity of the pages. The 
page can have one or more labels and the labels are arranged on the page in columns 
and rows. If you have eight labels on the page, the quantity of ten pages will print 80 
labels. 

When you are certain that the labels will be printed correctly and the preview shows the 
correct values, you can proceed to real printing. To actually print the labels, do the following: 

1. Click on  icon in the Standard toolbar. The Print dialog box appears. 
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2. Enter 10 for the Label Quantity and click on the Print button. Your printer will now 
print 10 labels. 

Note: 
To manage fast and easy label printing, you can print labels from the application 
GalleryPrint or the form generated with GalleryForm. For more information refer to the 
chapter Other Label Gallery Applications. 

Previewing Pictures 
When you place a picture on the label, in design mode it is always shown in color-depth as 
defined in the picture. 
However, when previewing the labels on-screen, the preview of the pictures depends on the 
dithering option set in the printer driver. All color pictures (except WMF and EMF files) are 
converted to monochrome images. The illusion of colors and shades of grey is accomplished 
by varying the pattern of dots. More dots close together will provide darker shade of grey. 
The preview of the label will show pictures in the same way as they will be printed 
accordingly to the dithering setting. More accurate print preview is guaranteed this way. 
If the picture is not previewed as you would like to print it, change the dithering setting in the 
printer driver. 

Use Custom Edit Forms 
If you have a lot of prompted variables on a label, you can use custom forms that allow user-
friendly data entry. 
Do the following: 

1. Open your label. 
2. Select Label Setup from the File menu. 
3. Go to Printing tab. 

Note: 
If Printing tab is not visible, click on the button Advanced at the bottom of the dialog 
box. 

4. Type in the name of the form file you want to use for printing. 
5. If the form does not exist, click on the button Define to create it. 
6. Click on the OK button. 

When you will select the Print command, the form will start and replace the standard Print 
dialog box in the Label Gallery software. 



 

156 

Integration and Connectivity 

Automatic Print with JOB Files 

Automatic Print 

Use this facility for automatic un-attending printing from the Label Gallery software. The 
commands to drive label printing from the Label Gallery application are stored in the batch 
command .JOB file. 
The Automatic Print can be used interactive in the Label Gallery with the command 
Automatic Print. The other possibility is to run Label Gallery with the parameter: 
GALLERY2.EXE SAMPLE2.JOB 
Label Gallery will start with execution of the commands, which are stored in the command 
file SAMPLE2.JOB. If the last command in this file is QUIT, the program will exit after 
printing. 

Automating the Software 

Automation with ActiveX 

Programming interface: Automation (ActiveX) 

The information in this chapter is for advanced users and application developers only. If you 
don't plan to write applications that use Label Gallery to print labels, you can skip this chapter 
entirely. 
Label Gallery can act as an OLE Automation server. Its class name is 
LabelGallery.Application. 
The commands actually allow you to have more control over Label Gallery from your own 
application. Active X allows also the status of variable managing procedure to be returned to 
your application so you can control printing process more accurately. A lot more 
programming functionality is allowed. The ActiveX interface makes is possible to query 
every label element for its properties. The same goes for variables and functions defined on 
the label. The properties of all label elements can be modified prior printing if for some 
reason you do not want to use label-defined settings. You can even create a label preview in 
your own application. 
For more information about programming interface please refer to the manual ActiveX and 
DDE Programming manual available on the Label CD-ROM and on Label Gallery website. 
You can also auto-generate the description of the interface using /typelib command-line 
parameter. It will create GALLERY2.OLB with description of methods, properties and 
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events Label Gallery Plus supports. Appropriate application for viewing .OLB files is 
required to be able to see the file contents. 

Programming Samples 

Programming examples of how to use Label Gallery as a print-engine from your applications 
are included with your copy of Label Gallery. By default they are installed to 
Samples\Integration folder. This is typically in C:\Program 
Files\Sato\Gallery\Samples\Integration. 
The samples are available for MS Word, MS Excel, MS Access, MS Visual Basic and 
Borland Delphi. Please refer to the file INTEGRATION.TXT in the same folder. It contains 
more technical information and description of enclosed programming sample files. It will help 
you start using the Label Gallery power from your custom application. 

Automation with DDE 

DDE Communication 

You can use DDE connection to print the labels from your Windows applications, that you 
develop in standard programming environments such as Microsoft Visual Basic, Borland 
Delphi, C, Microsoft Access?/p>  
To create the DDE communication the client application must use the following DDE 
parameters: 
Service = LabelGallery 
Topic=LINE or JOB 
When you are using topic JOB the content is the name of the command file, which must be 
run. When you are using topic LINE the content is one of the Label Gallery commands. 
When you want to use DDE communication to manage Label Gallery, it is probably the best, 
when the user doesn't know for the background running of this application. For this purpose 
you can use this command parameter: 
GALLERY2.EXE <label_name> /s 
The parameter s (silent) prevents that the Label Gallery will show on the screen. It is run in 
the minimized form.  

GalleryCommands Reference 

COMMENT 

; 
When developing program code or scripts it is very wise to well document your commands. 
This will help you decode what the script really performs, when you will look at the code 
after some time. 
Use semicolon (;) on the beginning of the line. Everything following it will be treated as 
script comment and will not be processed by application. 
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CREATEFILE 

CREATEFILE <name_of_the_file> 
This command will create a plain ASCII text file. The file will contain only one line of text 
"LabelGallery" (without the quotes). 
The purpose of creating such file is to signal some external application that the label 
processing or printing has began or has ended. 
The example of the CREATEFILE usage is printing labels with the data from some text file. 
First the external application prepares variable data for the labels and stores the data into the 
text file. Then Label Gallery is activated and printing starts. A CREATEFILE command is 
used to create a file on the disk. The appearance of the file represents a signal to the 
application that the current printing process is finished. 

DELETEFILE 

DELETEFILE <name_of_the_file> 
This command deletes the specified file. You can use it in combination with CREATEFILE 
command. 

GalleryCommands 

The printing with the Label Gallery can be automatic. There are two ways for automation. 
The first one is with the use of the command files (JOB file) which is used with Automatic 
print command from File menu. The second way is with the help of any other Windows 
application, which enables DDE communication between the programs. 
In the both ways you can use the same commands. When you are using the automatic print, 
the commands must be written one per line in the command file (JOB file). With the DDE 
communication the commands are send through the DDE channel. 

LABEL 

LABEL <name_of_the_file> 
The command opens the working label. If the label is already opened, the program will use 
this one. It is recommended to write full path name along with the file name. 
Note, if variable value contains space characters or commas, you will have to enclose the 
whole path in quotation marks (e.g. LABEL "C:\Program 
Files\Sato\Gallery2\Samples\Labels\sample3.lbl"). 
If you use LABEL command with GalleryWatch running in service mode, use UNC quotation 
instead of the mapped drives (e.g. LABEL "\\SERVER\SHARE\MY LABELS\LABEL.LBL" 
instead of "G:\MY LABELS\LABEL.LBL"). 

LABELCLOSE 

LABELCLOSE 
The command closes the currently active label. The label application will stay opened. 
FILECLOSE command does the same thing, but is depreciated. To speed up label printing do 
not use this command frequently. Label Gallery can have opened more label files 
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simultaneously. If the label is already opened, it does not have to be loaded and thus the label 
processing can be performed quickly. 

LOGIN 

LOGIN <username> 
Performs login procedure into Label Gallery program. This is necessary when login into 
Label Gallery is required. 
NOTE. This is a DDE command and should not be used in batch command .JOB files. 

MESSAGEBOX 

MESSAGEBOX message [, caption] 
Displays the message in the message box. The second parameter is used to define the title of 
the message dialog box. 
If the variable value contains space characters or commas, you have to enclose the text in 
quotation marks (e.g. MESSAGEBOX "Insert labels in printer", Warning). 

OEMTOANSI 

OEMTOANSI ON|OFF 
This command works in conjunction with command SET. It puts the text that follows the 
command SET in proper codepage, so that variable is assigned the proper value. 
Use it to put the values following SET command to the proper codepage, so correct values 
will be transferred to Label Gallery at print time. 

PORT 

PORT <file_name> 
This command overrides the printer's port name. This command is used to redirect print 
output to a file. In this case specify the name of the file in the parameter file_name. If the file 
path or filename contain space characters, enclose the whole string in double quotes. 

PRINT 

PRINT quantity [, skip [, identical label copies [, number of label sets]]] 
Command PRINT starts printing. The first parameter is the quantity of the labels that should 
be printed. 
<number> This many labels will be printed. 

VARIABLE Some variable contains the information how many labels should be printed. 
It can be label-defined prompted variable or a field from the database. 

UNLIMITED If you use a database to acquire values for variable fields, unlimited 
printing will print as many labels as there are record in the database. If you 
do not use a database, there is not much sense to use this option. In this case 
the maximum number of labels that thermal printer internally supports will 
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be printed. 

The parameter skip in the command represents the number of the labels you want to omit 
before first printed label on the page. The parameter is used for label printing on sheets of 
paper. When the part of the page is already printed, you can re-use the same sheet by shifting 
the start location of the first label. The rest of the unused labels on the page can be printed 
with the help of this parameter. 
The parameter identical label copies specifies how many copies of the same label should be 
printed. 
The parameter number of label sets specifies how many times the whole printing process 
should be repeated. 
If you do not need to set some of the supplementary parameters, use their default values. 
Skip 0 

Identical label copies 1 

Number of label sets 1 

 

PRINTER 

PRINTER <printer_name> 
Normally, the PRINT command prints the label to the printer specified in the label file. Using 
this command you can override this defined printer and print the label to some other printer. 
If the printer name contains space characters, you have to enclose it in quotation marks. 
For printer_name always use the system printer name as is displayed in the status line in the 
Label Gallery Plus application. System printer names are usually the same as the printer 
names in Printers folder from Control Panel, but not always, so pay attention. They differ only 
when you are using network-connected printers, when you should use "\\SERVER\SHARE" 
syntax and not a printer friendly name. 

PRINTJOBNAME 

PRINTJOBNAME <job_name> 
Specifies the print job name that will be used in print manager when using PRINT command. 
After printing the name is returned in normal state. Use this option to easier distinguish 
between different printing jobs in the Windows spooler. 
If variable value contains space characters or commas, you have to enclose the text in 
quotation marks (e.g. PRINTJOBNAME "Label for printing"). 

QUIT 

This command stops the labeling program after printing. The application is closed. 

RETURN 

This command returns focus to the main labeling program after the printing completes. 
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SESSIONEND 

The function closes data stream. 

SESSIONPRINT 

SESSIONPRINT quantity [, skip] 
You send the data stream to printer using this function. You can use multiple SessionPrint 
commands one after another and join them in single data stream. The stream is not closed 
until the command SessionEnd occurs. The meaning of quantity and skip parameters is the 
same as with GalleryCommand PRINT. 

SESSIONSTART 

All three commands(SessionStart, SessionPrint, SessionEnd) are used together. If ordinary 
command SessionPrint is used, every time a complete data stream for printer is sent. If you 
want to join multiple Print commands into one data stream, you can use the command 
SessionStart followed with any number of SessionPrint commands and in the end use the 
command SessionEnd. The stream is not closed until the command SessionEnd occurs. 
These commands offer a way of optimal label printing. It is not necessary to generate a 
complete data stream for each print session, you can join more sessions in one stream. 

SET 

SET name=value_of_the_variable, [,step[, quantity_of_repetition]] 
Name is the name of the variable defined on the label. If the variable isn't on the label, an 
error will occur. Step and Quantity_of_repetition are option parameter. These parameters tell 
the increment of the variable and the number of the labels before change. 
If variable value contains space characters or commas, you have to enclose the text in the text 
qualifier marks. By default the text qualifier is double quote character, but you can use any 
other character. 

SETDATABASE 

SETDATABASE <database_name> = <value> 
database_name The name of the currently used database as defined in the program. 

value The name of the new table that should be used as data source. 

 
This command allows you to use some other database with the label file and not the one, that 
was connected to the label file at design time. 
This other database will only be used when printing labels, the label file will remain intact 
with connection to the original database. 

SETPRINTPARAM 

SETPRINTPARAM paramname=value 
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This command allows you to set advanced print parameters before printing. 
Currently supported PARAMNAMES are: 
PAPERBIN Use it to specify from which tray the paper should be used. If the 

printer is equipped with more than just one paper / label tray, you can 
control which is used for printing. 
The name of the tray should be acquired from the printer driver. 

PRINTSPEED Use this parameter so specify printing speed. The value for parameter 
varies from one printer to the other. Consult printer's manuals for 
numbers. 

PRINTDARKNESS Use this parameter so specify printing darkness / contrast. The value 
for parameter varies from one printer to the other. Consult printer's 
manuals for numbers. 

 

SETTABLE 

SETTABLE <table_name> = <value> 
table_name The name of the currently used table as defined in the program. 

value The name of the new table that should be used as data source. 

 
This command allows you to use some other table with the label file and not the one, that was 
connected to the label file at design time. 
This other database table will only be used when printing labels, the label file will remain 
intact with connection to the original table. 
The new database table should be of the same type as original table. For example, you cannot 
change the table from dBase to Paradox. The structure of new table has to be identical to the 
original one. 
You can use table from the database that is already connected to the label or from some 
entirely different database. 

TEXTQUALIFIER 

TEXTQUALIFIER % 
Text-qualifier is the character that embeds a data value that is assigned to a variable. If the 
data value includes space characters, it must be included in the text-qualifier. Otherwise only 
the data until the first encountered space character is assigned to the variable. 
The default delimiter for the command SET is double-quote character. Because the double-
quote character is used as shortcut for inch unit of measure, sometimes it is difficult to pass 
the data with inch marks in the JOB files. 
The work-around is to use the double double-quote character instead of just one, but in this 
case already the incoming data stream needed to be changed. You can leave the incoming data 
stream as-is and change the delimiter you want to use. 
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For example: 
TEXTQUALIFIER % 
 
SET Var1 = % EPAK WRP BD 12"X10 7/32" %  
The command TEXTQUALIFIER set the delimiter to percent sign (%). The command SET 
can then use new delimiter character (%) for specifying the value to the variable Var1. 

Note: 
The command TEXTQUALIFIER is persistent (during single program session). If your 
JOB file sets the TEXTQUALIFIER to some value, it will be used until set to another 
value. 

Integration to SAP R3 

Integration to SAP/R3 

Label Gallery can be used to design labels that should be printed to thermal printers from SAP 
system. Two possible methods can be implemented. 

Printing from 
Label Gallery 
software 
using 
GalleryWatch 
integration 
module 

GalleryWatch data-detection module is used 
to integrate label printer to your existing 
SAP/R3 system. 
Labels are normally designed on Windows 
PC, where Label Gallery is installed. 
GalleryWatch runs on the same system. 
User on SAP/R3 system would export the 
data that should be used on the label to some 
ASCII file or true database file format. 
GalleryWatch will detect the appearance of 
the file and trigger label production. 
The advantage of this approach is that Label 
Gallery will process the labels on-the-fly. 
Labels will be imaged directly with data from 
exported database. There is full support for 
variable graphics elements, truetype fonts for 
variable fields and for advanced design 
options (usage of functions, VB Script etc.) 
All label printers with Windows driver can 
be used. 
The only disadvantage is that a PC computer 
with installed Windows operating system is 
required for label printing. 
For more information how GalleryWatch can 
be used for your specific demand, refer to 
GalleryWatch Operating Manuals. 

Printing 
directly from 
SAP/R3 

Using this option the labels are designed with 
Label Gallery software on a PC computer 
and are then exported to SAP format. Export 
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procedure will generate .ITF native file with 
description of the label. This .ITF file is then 
uploaded to SAP system and users can print 
labels directly from SAP/R3. 
The advantage with this approach is that no 
PC is required for label printing. Once the 
label is created, you do not need Label 
Gallery application any more. 
However, there are several disadvantages. 
First of all, every label printer is not suitable 
for label printing directly from SAP/R3 
system. SAP has certain limitations that the 
printer has comply to. There is also limited 
support for graphics elements. Variable 
graphics cannot be used at all. And only 
some printer models support printing of fixed 
images/truetype fonts. Variable text fields on 
the label has to be set in internal printer fonts 
that usually do not look as good as truetype 
fonts. Only prompted variables can be used. 
Since Label Gallery Plus application is not 
present at print-time, functions and advanced 
label elements cannot be used. 

 
For more information about connecting labeling software to SAP R/3 system please refer to 
the appropriate White Paper on the web site of contact technical support. 

Label Export 

Label Export 

Label Export functionality is used heavily from stand-alone and some print-only variants of 
this labeling software. Its functionality is tightly connected to the ability of printer that is used 
on the label. Export is only available when using native thermal printer drivers. The printer 
driver also has to have the support for the required export built-in. 
Windows version of labeling software on PC computer is used to design the label layout 
compliant to the labeling request. All label elements can be used on the label (text, paragraph, 
RTF, bar code, image, line, rectangle, ellipse, ...). When printing fixed labels, there is no issue 
you should pay attention to. The label elements are printed as graphics. 
But if you use variable fields on the label, you have to pay special attention to their format. 
All variable elements must follow some designing rules. 
All variables 
on the label 
have to be 
prompted 

User must be able to set their values 
before printing. Date/Time variables 
have to acquire the data from the printer 
clock not from PC system clock. 
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Support for 
functions is 
limited 
(Concatenate, 
Subset, etc). 

As PC labeling software is not available 
at print time, the functions cannot be 
processed. 

All counters 
have to be 
incremented 
by printer 

There are some exceptions, for example 
Export to Pocket PC, where some 
functions can be used, because the 
application that will eventually print 
these files knows how to process them. 

Variable 
graphics are 
not 
supported 

Because PC labeling software is not 
available at print-time, it cannot handle 
the variable graphics. Any image on the 
label has to be static. 

Label Export is one method of label printing from outside of labeling application. It requires 
some other application to be able to open exported label format, parse it and then print it. 
There are numerous other possibilities to integrate label printing to existing systems. More 
information is available on Label Gallery web site. 

Command line options 
The following command line options can be used when starting the main labeling application. 
LGPLUS2.EXE [file_name] [options] 
[file_name] Represents the full path name of the file. If the label file is given, then this label 
is opened. If JOB file is given, then this JOB file is executed. For more information about 
JOB files, refer to the topic GalleryCommands. 
[options] can be on or more of the following: 
/s Silent mode, no toolbar, menu or banner is displayed and window is minimized. 

This is useful when using Label Gallery as label printing engine for label 
production from other application. 

/r Registers Label Gallery as an OLE server. 

/u Unregisters Label Gallery as an OLE server. 

/i After JOB file is finished, Label Gallery exits. 

/typelib This option will generate LGPLUS2.OLB file with type library description of 
Label Gallery ActiveX interface. The file contains COM interface description to 
Label Gallery, if you would like to integrate Label Gallery functionality to your 
application. 

 



Label Gallery User Guide 

166 

Overview 
The most common method is to print labels directly from Label Gallery. But sometimes there 
might be other requirements of label production. Label Gallery has a wide connectivity and 
integration options so you do not have to use Label Gallery interactively but through ActiveX 
interface or DDE connectivity. Label Gallery can be used as a "print-engine" totally 
integrated to your custom application and invisible to end-user's eyes. 
If you do not require such tight integration to your application, you can use GalleryWatch, 
add-on utility for non-programming integration to existing systems and fully automated 
printing. A set of actions is defined that are trigger if pre-defined event occurs. These actions 
can open the label, connect it to database, fill variable's values, connect to proper printer and 
print the required number of labels. You can even build your custom data-entry and printing 
applications with GalleryForm in a totally user friendly way without any programming skills 
required. 
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Technical Support 

Contact Information 
Sato International Pte. Ltd. 

438A, Alexandra Road, #05-01/02 

Alexandra Technopark, 

Singapore 119967 

Tel: 65-6271-2122 

Fax: 65-6271-2151 

Sales: sales@sato-int.com 

Technical Support: softwaresupport@sato-int.com 

Website: http://www.satoworldwide.com 

 

Sato America Inc. 

10350 Nation Ford Road Suite A 

Charlotte, NC 28273 

Tel: 1-704-644-1650 

Fax: 1-704-644-1662 

Sales: sales@satoamerica.com 

Technical Support: techsupport@satoamerica.com 

Website: http://www.satoamerica.com 

 

Sato UK Ltd. 

Valley Road, Harwich, Essex England 

Co12 4RR, United Kingdom 

Tel: 44-1255-240000 

Fax: 44-1255-240111 
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Sales: enquiries@satouk.com 

Technical Support: techsupport@sato-uk.com 

Website: http://www.sato-uk.com 

 

Sato Europe NV 

Leuvensesteenweg, 369 

1932 Sint-Stevens-Woluwe 

Brussels, Belgium 

Tel: 32 (0) 2-788-80-00 

Fax: 32 (0) 2-788-80-80 

Sales: info@be.satoeurope.com 

Technical Support: technical.support@be.satoeurope.com 

Website: http://www.sato-europe.com 

 

Sato Deutschland GMBH 

Schaberweg 28, 61348 

Bad Homburg, Germany 

Tel: 49-6172-68180 

Fax: 49-6172-6818-199 

Sales: info@de.satoeurope.com 

Technical Support: softwaresupport@sato-deutschland.de 

Website: http://www.sato-deutschland.de 

 

Sato Polska SP Z O. O. 

ul. Wroclawska 123 

55-015 Radwanice k/Wroclawia, Poland 

Tel: 48-71-381-03-60 

Fax: 48-71-381-03-68 

Sales: biuro@pl.satoeurope.com 
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Technical Support: technical.support@be.satoeurope.com 

Website: http://www.sato-europe.com 

 

Sato France s.a 

Parc D'Activities 

Rues Jacques Messager 

59175 Templemars, France 

Tel: 33-3-20-62-96-40 

Fax: 33-3-20-62-96-55 

Sales: info@fr.satoeurope.com 

Technical Support: technical.support@be.satoeurope.com 

Website: http://www.sato-europe.com 

 
Sato Asia Pacific Pte. Ltd. 

438A, Alexandra Road, #05-01/02 

Alexandra Technopark, 

Singapore 119967 

Tel: (65) 6-271-5300 

Fax: (65) 6-273-6011 

Sales: sales@satoasiapacific.com 

Technical Support: technical@satoasiapacific.com 

Website: http://www.satoasiapacific.com 

 

Sato Shanghai Co. Ltd. 

307 Haining Road, ACE Building 

10TH Floor, Hongkou Area 

Shanghai, China 200080 

Tel: (86) 021-63068899 

Fax: (86) 021-63091318 
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Sales: sales@satochina.com 

Technical Support: technical@satoasiapacific.com 

Website: http://www.satochina.com 

 
Sato Auto-ID Malaysia Sdn. Bhd. 

No. 25, Jalan Pemberita U1/49 

Temasya Industrial Park 

Section U1, 40150 Shah Alam, Selangor Darul Ehsan 

Tel: 60-3-7620-8901 

Fax: 60-3-5569-4977 

Sales: sales@satosms.com.my 

Technical Support: technical@satoasiapacific.com 

Website: http://www.satoasiapacific.com 

 
Sato Auto-ID (Thailand) Co. Ltd. 

292/1 Moo 1 Theparak Road, Tumbol 

Theparak, Amphur Muang 

Samutprakarn 10270 

Tel: 662-736-4460 

Fax: 662-736-4461 

Sales: sales@satothailand.co.th 

Technical Support: technical@satoasiapacific.com 

Website: http://www.satoasiapacific.com 

 

Online Support 
You can find the latest builds, updates, workarounds for problems and Frequently Asked 
Questions (FAQ) under the Support section on our Web site at www.satoworldwide.com. If 
you cannot solve the problem on your own, please contact your local vendor or representative 
offices listed in the topic Contact Information. 
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For more information please refer to: 
• Label Gallery FAQ: 

http://www.satoworldwide.com/labelgallery/support_faq_general.htm 
• Label Gallery eHelp: http://www.satoworldwide.com/labelgallery/support_ehelp.htm

 


